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Introduction

When Visual Basic first appeared, it revolutionized Windows programming. By handling many of the
tedious details of processing Windows events, it enabled programmers to focus on application details
instead of Windows programming trivia.

Unfortunately, early versions of Visual Basic had a few drawbacks. Protection from the underlying
Windows details came at the price of reduced flexibility. Using Visual Basic meant you didn’t need to
mess with the sticky details of Windows event loops, but it also made working directly with those
events more difficult when you really wanted to. Advanced programmers could still pry off the cover
and work at this lower level, but this was somewhat dangerous. If your code didn’t handle all the details
correctly, it could crash the program and possibly Windows itself.

Visual Basic also followed a path different from that taken by other Windows programming languages
such as C++. It provided a more productive development environment and a generally more intuitive
syntax. Its syntax for object-oriented development was more restrictive, however. A developer could still
build safe, reliable, extensible applications, but it took some experience and care.

Visual Studio .NET addressed many of these shortcomings. It merged the Visual Basic and C++ develop-
ment environments into an even more powerful tool. It added the C# language (pronounced “C-sharp”)
and gave all three a common underlying run-time language called Common Language Runtime (CLR).
Visual Basic .NET incorporated changes to bring the language more into line with CLR and the other
languages. It included more structured error handling, new syntax for declaring and initializing vari-
ables, overloaded functions and subroutines, and a more powerful model for creating classes that
include true inheritance.

Visual Basic 2005 adds new features that make Visual Basic a more powerful language than ever. It
includes new language features such as unsigned data types, operator overloading, and short-circuit
logical operators; object-oriented enhancements such as more flexible property procedure accessibility,
generics, and custom events; and coding improvements such as Extensible Markup Language (XML)
comments, better IntelliSense, and code snippets.

Visual Basic 2005 is the language’s second major release. Most of the obvious bugs in the first release
(surprisingly few for such a major reshaping of the language) have been ironed out, so there has never
been a better time to learn the language. The first release has proven stable and the current release brings
new capabilities to Visual Basic programmers. Developers waiting to see what would become of Visual
Basic .NET have their answer: it is here to stay.

Should You Use Visual Basic .NET?

A Visual Basic programmer’s joke asks, “What’s the difference between Visual Basic .NET and C#?
About three months!” The implication is that Visual Basic .NET syntax is easier to understand, and
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building applications with it is faster. Similarly, C# programmers have their jokes about Visual Basic
.NET, implying that C# is more powerful.

In fact, Visual Basic .NET is not a whole lot easier to use than C#, and C# is not significantly more power-
ful. The basic form of the two languages is very similar. Aside from a few stylistic differences (Visual
Basic is line-oriented; C# uses lots of braces and semicolons), the languages are comparable. Both use the
Visual Studio development environment, both provide access to the NET Framework of support classes
and tools, and both provide similar syntax for performing basic programming tasks.

In fact, the languages are so similar that many of Microsoft’s Web pages lump the two together. For exam-
ple, the page http://msdn.microsoft.com/library/en-us/vbcon/html/vboriWhatsNewVB70.asp
is titled “What’s New in Visual Basic and Visual C#.”

The main difference between these languages is one of style. If you have experience with previous ver-
sions of Visual Basic, you will probably find Visual Basic .NET easier to get used to. If you have experi-
ence with C++ or Java, you will probably find C# (or Visual C++ or Visual J#) easy to learn.

Visual Basic does have some ties with other Microsoft products. For example, ASP uses Visual Basic to
create interactive Web pages. Microsoft Office applications (Word, Excel, PowerPoint, and so forth) and
many third-party tools use Visual Basic for Applications (VBA) as a macro programming language. If
you know Visual Basic, you have a head start in using these other languages. Active Server Pages (ASP)
and Visual Basic for Application (VBA) are based on pre-.NET versions of Visual Basic, so you won't
instantly know how to use them, but you’ll have a big advantage if you need to learn ASP or VBA.

If you are new to programming, either Visual Basic .NET or C# is a good choice. I think Visual Basic
.NET may be a little easier to learn, but I may be slightly biased because I've been using Visual Basic
lately. You won't be making a big mistake either way, and you can easily switch later. Of course, if you
have already bought this book, you should stick with Visual Basic to get the most benefit.

Who Should Read This Book

Vi

This book is intended for programmers of all levels. It describes the Visual Basic .NET language from
scratch, so you don’t need experience with previous versions of the language. The book also covers
many intermediate and advanced topics. It covers topics in enough depth that even experienced devel-
opers will discover new tips, tricks, and language details. After you have mastered the language, you
may still find useful tidbits throughout the book, and the reference appendices will help you look up
easily forgotten details.

The chapters move quickly through the more introductory material. If you have never programmed
before and are intimidated by computers, then you might want to read a more introductory book first. If
you are a beginner whos not afraid of the computer, then you should have few problems learning Visual
Basic .NET from this book.

If you have programmed in any other language, then fundamentals such as variable declarations, data
types, and arrays should be familiar to you, so you should have no problem with this book. The index
and reference appendices should be particularly useful in helping you translate from the languages you
already know into the corresponding Visual Basic syntax.
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How This Book Is Organized

You could divide the chapters in this book into four parts plus appendices. The chapters in each part are
described here. If you are an experienced programmer, you can use these descriptions to decide which
chapters to skim and which to read in detail.

Part I: Getting Started

The chapters in this part of the book explain the basics of Visual Basic .NET programming. They describe
the development environment, basic program syntax, and how to interact with standard controls. More
advanced topics include how to build custom controls and how to implement drag and drop.

Chapter 1, “IDE,” describes the integrated development environment (IDE). It explains the IDE’s win-
dows and how to customize the IDE. It also explains tools that provide help while you're programming
such features as the Object Browser and the code window’s Intellisense.

Chapter 2, “Controls in General,” describes general control concepts. It explains how to add controls to a
form, how to read and change a control’s properties at design time and at run time, and how to use
some of the more complicated control properties (such as Dock and Anchor). This chapter shows how to
catch and respond to events, and how to change event handlers in code.

Chapter 3, “Program and Module Structure,” analyzes a simple Visual Basic program and explains the
structure created by Visual Studio. It describes the program’s code regions and comments, and tells how
you can use similar techniques to make your code more readable and manageable.

Chapter 4, “Data Types, Variables, and Constants,” explains the standard data types provided by Visual
Basic. It shows how to declare and initialize variables and constants, and explains variable scope. It dis-
cusses value and reference types, passing parameters by value or reference, and creating parameter vari-
ables on the fly. It also explains how to create arrays, enumerated types, and structures.

Chapter 5, “Operators,” describes the operators a program uses to perform calculations. These include
mathematical operators (+, *, \), string operators (&), and Boolean operators (And, Or). The chapter
explains operator precedence and type conversion issues that arise when an expression combines more
than one type of operator (for example, arithmetic and Boolean).

Chapter 6, “Subroutines and Functions,” explains how you can use subroutines and functions to break a
program into manageable pieces. It describes routine overloading and scope.

Chapter 7, “Program Control Statements,” describes the statements that a Visual Basic program uses to
control code execution. These include decision statements (If Then Else, Select Case, IIF, Choose)
and looping statements (For Next, For Each, Do While, While Do, Repeat Until).

Chapter 8, “Error Handling,” explains error handling and debugging techniques. It describes the Try
Catch structured error handler in addition to the older On Error statement inherited from earlier ver-
sions of Visual Basic. It discusses typical actions a program might take when it catches an error. It also
describes techniques for preventing errors and making errors more obvious when they do occur.

Chapter 9, “Introduction to Windows Forms Controls,” explains the Visual Basic’s standard controls that
you can use on Windows forms. It describes the most useful properties, methods, and events provided

vii
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by these controls, and it gives examples showing how to use them. It also describes cases where these
controls rely on each other. For example, several controls such as the ToolBar obtain images from an
associated ImageList control.

Chapter 10, “Forms,” explains typical uses of forms. It tells how to build partially transparent forms for
use as splash, login, and About forms. It describes form cursors and icons, how to override WndProc to
intercept a form’s Windows messages, how to make a Multiple Document Interface (MDI) application,
and how to implement a Most Recently Used (MRU) file list. It does not cover all of the Form object’s
properties, methods, and events in detail; those are described in Appendix H, “Form Objects.”

Chapter 11, “Database Controls and Objects,” explains how to use Visual Basic’s standard database con-
trols. These include database connection components that handle connections to a database, Dataset
components that hold data within an application, and data adapter controls that move data between
data connections and DataSets.

Chapter 12, “Custom Controls,” explains how to build your own customized controls that you can then
use in other applications. It covers the three main methods for creating a custom control: derivation,
composition, and building from scratch. This chapter also provides several examples that you can use as
a starting point for controls of your own.

Chapter 13, “Drag and Drop, and the Clipboard,” explains how a Visual Basic program can support
drag-and-drop operations. It tells how your program can start a drag to another application, how to
respond to drag operations started by another application, and how to receive a drop from another
application. This chapter also explains how a program can copy data to and from the clipboard. Using
the clipboard is similar to certain types of drag-and-drop operations, so these topics fit naturally in
one chapter.

Part II: Object-Oriented Programming

viii

The chapters in this part of the book explain fundamental concepts in object-oriented programming
(OOP) with Visual Basic. It also describes some of the more important classes and objects that you can
use when building an application.

Chapter 14, “OOP Concepts,” explains the fundamental ideas behind object-oriented programming. It
describes the three main features of OOP: encapsulation, polymorphism, and inheritance. It explains the
benefits of these features and tells how you can take advantage of them in Visual Basic.

Chapter 15, “Classes and Structures,” explains how to declare and use classes and structures. It explains
what classes and structures are, and it describes their differences. It shows the basic declaration syntax
and tells how to create instances of classes and structures. It also explains some of the trickier class
issues (such as private class scope, declaring events, and shared variables and methods).

Chapter 16, “Namespaces,” explains namespaces. It tells how Visual Studio uses namespaces to catego-
rize code and to prevent name collisions. It describes a project’s root namespace, tells how Visual Basic
uses namespaces to resolve names (such as function and class names), and tells how you can add names-
paces to an application yourself.

Chapter 17, “Collection Classes,” explains classes included in Visual Studio that you can use to hold
groups of objects. It describes the various collection, dictionary, queue, and stack classes; tells how to
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make strongly typed versions of those classes; and gives some guidance on deciding which class to use
under different circumstances.

Chapter 18, “Generics,” explains templates that you can use to build new classes designed to work with
specific data types. For example, you can build a generic binary tree and then later use it to build classes
to represent binary trees of customer orders, employees, or work items.

Part Ill: Graphics

The chapters in this part of the book describe graphics in Visual Basic .NET. They explain the Graphics

Device Interface+ (GDI+) routines that programs use to draw images in Visual Basic. They explain how
to draw lines and text; how to draw and fill circles and other shapes; and how to load, manipulate, and
save bitmap images. This part also explains how to generate printed output and how to send reports to
the screen or to the printer.

Chapter 19, “Drawing Basics,” explains the fundamentals of drawing graphics in Visual Basic .NET. It
describes the graphics namespaces and the classes they contain. It describes the most important of these
classes, Graphics, in detail. It also describes the Paint event handler and other events that a program
should use to keep its graphics up to date.

Chapter 20, “Brushes, Pens, and Paths,” explains the most important graphics classes after Graphics:
pen and Brush. It tells how you can use Pens to draw solid lines, dashed lines, lines with custom

dash patterns, and lines with custom lengthwise stripe patterns. It tells how to use Brushes to fill areas
with colors, hatch patterns, linear color gradients, color gradients that follow a path, and tiled images.
This chapter also describes the GraphicsPath class, which represents a series of lines, shapes, curves,
and text.

Chapter 21, “Text,” explains how to draw strings of text. It shows how to create different kinds of fonts,
determine exactly how big text will be when drawn in a particular font, and use GDI+ functions to make
positioning text simple. It shows how to use a StringFormat object to determine how text is aligned,
wrapped, and trimmed, and how to read and define tab stops.

Chapter 22, “Image Processing,” explains how to load, modify, and save image files. It shows how to
read and write the pixels in an image, and how to save the result in different file formats such as

BMP GIF, and JPEG. It tells how to use images to provide auto-redraw features, and how to manipulate
an image pixel by pixel, both using a Bitmap’s GetPixel and SetPixel methods and using “unsafe”
access techniques that make pixel manipulation much faster than is possible with normal GDI+ methods.

Chapter 23, “Printing,” explains different ways that a program can send output to the printer. It shows
how you can use the PrintDocument object to generate printout data. You can then use the
PrintDocument to print the data immediately, use a PrintDialog control to let the user select the
printer and set its characteristics, or use a PrintPreviewDialog control to let the user preview the
results before printing.

Chapter 24, “Reporting,” provides an introduction to Crystal Reports, a tool that makes generating
reports in Visual Basic relatively easy. The chapter explains the basics of Crystal Reports and steps
through an example that builds a simple report.
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Part IV: Interacting with the Environment

The chapters in this part of the book explain how an application can interact with its environment. They
show how the program can save and load data in external sources (such as the System Registry, resource
files, and text files); work with the computer’s screen, keyboard, and mouse; and interact with the user
through standard dialog controls.

Chapter 25, “Configuration and Resources,” describes some of the ways that a Visual Basic program can
store configuration and resource values for use at run time. Some of the most useful of these include
environment variables, the Registry, configuration files, and resource files.

Chapter 26, “Streams,” explains the classes that a Visual Basic application can use to work with stream
data. Some of these classes are FileStream, MemoryStream, Buf feredStream, TextReader, and
TextWriter.

Chapter 27, “File-System Objects,” describes classes that let a Visual Basic application interact with the
file system. These include classes such as Directory, DirectoryInfo, File, and FileInfo that make
it easy to create, examine, move, rename, and delete directories and files.

Chapter 28, “Useful Namespaces,” describes some of the most commonly useful namespaces defined by
the NET Framework. It provides a brief overview of some of the most important System namespaces
and gives more detailed examples that demonstrate regular expressions, XML, cryptography, reflection,
threading, and Direct3D.

Appendixes

The book’s appendices provide a categorized reference of the Visual Basic .NET language. You can use
them to quickly review the syntax of a particular command, select from among several overloaded ver-
sions of a routine, or refresh your memory of what a particular class can do. The chapters earlier in the
book give more context, explaining how to perform specific tasks and why one approach might be pre-
ferred over another.

Appendix A, “Useful Control Properties, Methods, and Events,” describes properties, methods, and
events that are useful with many different kinds of controls.

Appendix B, “Variable Declarations and Data Types,” summarizes the syntax for declaring variables. It
also gives the sizes and ranges of allowed values for the fundamental data types.

Appendix C, “Operators,” summarizes the standard operators such as +, <<, OrElse, and Like. It also
gives the syntax for operator overloading.

Appendix D, “Subroutine and Function Declarations,” summarizes the syntax for subroutine, function,
and property procedure declarations.

Appendix E, “Control Statements,” summarizes statements that control program flow such as If Then,
Select Case, and looping statements.

Appendix F, “Error Handling,” summarizes both structured and “classic” error handling. It describes
some useful exception classes and gives an example showing how to build a custom exception class.
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Appendix G, “Standard Controls and Components,” describes standard components provided by Visual
Basic .NET. It explains the properties, methods, and events that I have found most useful when working
with these components.

Appendix H, “Form Objects,” describes forms. In a very real sense, forms are just another type of com-
ponent. They play such a key role in Visual Basic applications, however, that they deserve special atten-
tion in their own appendix.

Appendix I, “Classes and Structures,” summarizes the syntax for declaring classes and structures, and
defining their constructors and events.

Appendix ], “Generics,” summarizes the syntax for declaring generic classes.

Appendix K, “Graphics,” summarizes the objects used to generate graphics in Visual Basic .NET. It cov-
ers the most useful graphics namespaces.

Appendix L, “Useful Exception Classes,” lists some of the more useful exception classes defined by
Visual Basic. You may want to throw these exceptions in your own code.

Appendix M, “Date and Time Format Specifiers,” summarizes specifier characters that you can use to
format dates and times. For example, they let you display a time using a 12-hour or 24-hour clock.

Appendix N, “Other Format Specifiers,” summarizes formatting for numbers and enumerated types.

Appendix O, “The application Class,” summarizes the Application class that provides properties
and methods for controlling the current application.

Appendix P, “The My Namespace,” describes the My namespace, which provides shortcuts to useful
features scattered around other parts of the NET Framework. It provides shortcuts for working with the
application, computer hardware, application forms, resources, and the current user.

Appendix Q, “Streams,” summarizes Visual Basic’s stream classes such as Stream, FileStream,
MemoryStream, TextReader, CryptoStream, and so forth.

Appendix R, “File-System Classes,” summarizes methods that an application can use to learn about and
manipulate the file system. It explains classic Visual Basic methods such as FreeFile, WriteLine, and
ChDir, as well as newer NET Framework classes such as FileSystem, Directory, and File.

How to Use This Book

If you are an experienced Visual Basic .NET programmer, you may want to skim the language basics
covered in the first parts of the book. You may find a few new features that have appeared in Visual
Basic 2005, so you probably shouldn’t skip these chapters entirely, but most of the basic language fea-
tures are the same as in previous versions.

Intermediate programmers and those with less experience with Visual Basic .NET should take these

chapters a bit more slowly. The chapters in Part II, “Object-Oriented Programming,” cover particularly
tricky topics. Learning all the variations on inheritance and interfaces can be rather confusing.

Xi
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Beginners should spend more time on these first chapters because they set the stage for the material that
follows. It will be a lot easier for you to follow a discussion of file management or regular expressions if
you are not confused by the error-handling code that the examples take for granted.

Programming is a skill best learned by doing. You can pick up the book and read through it quickly if
you like, but the information is more likely to stick if you open the Visual Basic .NET development envi-
ronment and experiment with some programs of your own. Normally, when I read a new programming
book, I work through every example myself, modifying the code to see what happens if I try different
things not covered by the author. I experiment with new variations and pay particular attention to
errors, which are hard to cover completely in a book. It’s one thing to read about strongly typed collec-
tions; it’s another to build one yourself using data that is meaningful to you.

Learning by doing may encourage you to skip sections of the book. For example, Chapter 1 covers the
interactive development environment in detail. After you've read for a while, you may want to skip
some sections and start experimenting with the environment on your own. I encourage you to do so.
Lessons learned by doing stick better than those learned by reading. Later, when you have some experi-
ence with the development environment, you can go back and examine Chapter 1 in more detail to learn
more advanced customization techniques.

The final part of the book is a Visual Basic .NET reference. These appendices present more concise, cate-
gorized information about the language. You can use these appendices to recall the details of specific
operations. For example, you can read Chapter 9 to learn which controls are useful for different pur-
poses. Then use Appendix G to learn about specific controls” properties, methods, and events.

Throughout your work, you can also refer to the appendices to get information on specific classes, con-
trols, and syntax. For example, you can quickly find the syntax for declaring a generic class in Appendix
J. If you need more information on generics, you can find it in Chapter 18 or the online help. If you just
need to refresh your memory of the basic syntax, however, scanning Appendix J will be faster.

Necessary Equipment

Xii

To read this book and understand the examples, you will need no special equipment. To use Visual Basic
.NET and to run the examples found on the book’s Web page, you need any computer that can reason-
ably run Visual Basic .NET. That means a reasonably modern, fast computer with a lot of memory. See
the Visual Basic .NET documentation for Microsoft’s exact requirements and recommendations.

To build Visual Basic .NET programs, you will also need a copy of Visual Basic .NET. Don’t bother trying
to run the examples shown here if you have a pre- NET version of Visual Basic such as Visual Basic 6.
The changes between Visual Basic 6 and Visual Basic .NET are huge, and many Visual Basic .NET con-
cepts don’t translate well into Visual Basic 6. With some experience in C#, it would be much easier to
translate programs into that language.

Much of the Visual Basic 2005 release is compatible with Visual Basic .NET 2003 and earlier versions of
Visual Basic .NET, however, so you can make many of the examples work with earlier versions of Visual
Basic .NET. You will not be able to load the example programs downloaded from the book’s Web site,
however. You will need to copy and paste the significant portions of the code into your version of Visual
Basic .NET.
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The Book’s Web Site

On the book’s Web site, www . vb-helper.com/vb_prog_ref.htm, you can do the following:

QO  Download the examples in this book

Q  Download other Visual Basic programming examples

Q  View updates and corrections

O  Read other readers’ comments and suggestions
This book was written using beta versions of Visual Basic 2005. Microsoft often makes changes between
beta versions and the final release (the whole point of the betas is to identify areas that need fixing or

modification) and sometimes even produces patch releases shortly after the main product rollout. The
book’s Web page will include any modifications that the examples need to handle those changes.

If you have corrections or comments of your own, please send them to me at RodStephens@vb-helper.
com. [ will do my best to keep the Web site as up to date as possible.

Xiii
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This chapter describes Visual Studio’s integrated development environment (IDE). It explains the
most important windows, menus, and toolbars that make up the environment, and shows how to
customize them to suit your personal preferences. It also explains some of the tools that provide
help while you are writing Visual Basic applications.

Even if you are an experienced Visual Basic programmer, you should at least skim this material.
The IDE is extremely complex and provides hundreds (if not thousands) of commands, menus,
toolbars, windows, context menus, and other tools for editing, running, and debugging Visual
Basic projects. Even if you have used the IDE for a long time, there are sure to be some features
that you have overlooked. This chapter describes some of the most important of those features,
and you may discover something useful that you've never noticed before.

Even after you've read this chapter, you should periodically spend some time wandering through
the IDE to see what you’ve missed. Every month or so, spend a few minutes exploring the menus
and right-clicking on things to see what their context menus contain. As you become a more profi-
cient Visual Basic programmer, you will find uses for tools that you may have previously dis-
missed or failed to understand.

It is important to remember that the Visual Studio IDE is extremely customizable. You can move,
hide, or modify the menus, toolbars, and windows; create your own toolbars; dock, undock, or
rearrange the toolbars and windows; and change the behavior of the built-in text editors (change
their indentation, colors for different kinds of text, and so forth).

These capabilities let you display the features you need the most and hide those that are unneces-
sary for a particular situation. If you need to use the Properties window, you can display it. If you
want to make room for a very wide form, you can make it short and wide, and move it to the bot-
tom of the screen. If you have a collection of favorite tools and possibly some you have written
yourself, you can put them all in one convenient toolbar. Or you can have several toolbars for
working with code, forms in general, and database forms in particular.

This chapter describes the basic Visual Studio development environment as it is initially installed.
Because Visual Studio is so flexible, your development environment may not look like the one
described here. After you've moved things around a bit to suit your personal preferences, your
menus and toolbars may not contain the same commands described here, and other windows may
be in different locations or missing entirely.
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To avoid confusion, you should probably not customize the IDE’s basic menus and toolbars too much.
Removing the help commands from the Help menu and adding them to the Edit menu will only cause
confusion later. It’s less confusing to leave the menus more or less alone. Hide any toolbars you don’t
want and create new customized toolbars to suit your needs. Then you can find the original standard
toolbars if you decide you need them later. The section “Customize” later in this chapter has more to say
about rearranging the IDE’s components.

This chapter describes the Visual Studio IDE. Before you can understand how to use the IDE to manage
Visual Basic projects and solutions, however, you should know what projects and solutions are.

Projects and Solutions

A project is a group of files that produces some specific output. This output may be a compiled exe-
cutable program, a dynamic-link library (DLL) of classes for use by other projects, or a custom control
for use on other Windows forms.

A solution is a group of one or more projects that should be managed together. For example, suppose that
you are building a server application that provides access to your order database. You are also building a
client program that each of your sales representatives will use to query the server application. Because
these two projects are closely related, it might make sense to manage them in a single solution. When
you open the solution, you get instant access to all the files in both projects.

Both projects and solutions can include associated files that are useful for building the application but
that do not become part of a final compiled product. For example, a project might include the applica-
tion’s proposal and architecture documents. These are not included in the compiled code, but it is useful
to associate them with the project.

When you open the project, Visual Studio lists those documents along with the program files. If you
double-click one of these documents, Visual Studio opens the file using an appropriate application.
For example, if you double-click a file with a .doc extension, Visual Studio normally opens it with
Microsoft Word.

To associate one of these files with a project or solution, right-click the project in the Solution Explorer
(more on the Solution Explorer shortly). Select the Add command’s Add New Item entry, and use the
resulting dialog to select the file you want to add.

Often a Visual Basic solution contains a single project. If you just want to build a small executable pro-
gram, you probably don’t need to include other programming projects in the solution.

Another common scenario is to place Visual Basic code in one project and to place documentation (such
as project specifications and progress reports) in another project within the same solution. This keeps the
documentation handy whenever you are working on the application but keeps it separate enough that it
doesn’t clutter the Visual Studio windows when you want to work with the code.

While you can add any file to a project or solution, it’s not a good idea to load dozens of unrelated files.
While you may sometimes want to refer to an unrelated file while working on a project, the extra clutter
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brings additional chances for confusion. It will be less confusing to shrink the Visual Basic IDE to an icon
and open the file using an external editor such as Word or WordPad. If you won't use a file very often
with the project, don’t add it to the project.

IDE Overview

Figure 1-1 shows the IDE immediately after starting a new project. The IDE is extremely configurable, so
it may not look much like Figure 1-1 after you have rearranged things to your own liking.

If you don’t have a reason to modify the IDE’s basic arrangement, you should probably leave it alone.
Then when you read a magazine article that tells you to use the Project menu’s Add Reference com-
mand, the command will be where it should be. Using the standard IDE layout also reduces confusion
when you need to consult with another developer. It’s a lot easier to share tips about using the Format
menu if you haven’t removed that menu from the IDE.
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Figure 1-1: Initially the IDE looks more or less like this.
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The key pieces of the IDE are labeled with numbers in Figure 1-1. The following list briefly describes
each of these pieces.

Qa

(1) Menus — The menus contain standard Visual Studio commands. These generally manipu-
late the current solution and the modules it contains, although you can customize the menus as
needed. Visual Studio changes the menus, and their contents depending on the object you cur-
rently have selected. In Figure 1-1, a Form Designer (marked with the number 4) is open so the
IDE is displaying the menus for editing forms.

(2) Toolbars — Toolbars contain tools that you can use to perform frequently needed actions.
The same commands may be available in menus, but they are easier and faster to use in tool-
bars. The IDE defines several standard toolbars such as Formatting, Debug, and Image Editor.
You can also build your own custom toolbars to hold your favorite tools. Visual Studio changes
the toolbars displayed to match the object you currently have selected.

(3) Toolbox — The Toolbox contains tools appropriate for the item that you currently have
selected and for the project type that you are working on. In Figure 1-1, a Form Designer is
selected in a Windows Forms application so the Toolbox contains tools appropriate for a Form
Designer. These include Windows Forms controls and components, plus tools in the other
Toolbox tabs: Crystal Reports, Data, and Components (plus the General tab is scrolled off the
bottom of the Toolbox). You can add other customized tabs to the Toolbox to hold your favorite
controls and components. Other project types may display other tools. For example, a Web proj-
ect would display Web controls and components instead of Windows Forms components.

(4) Form Designer — A Form Designer lets you modify the graphical design of a form. Select a
control tool from the Toolbox, and click and drag to place an instance of the control on the form.
Use the Properties window (marked with the number 6) to change the new control’s properties.
In Figure 1-1, no control is selected, so the Properties window shows the form'’s properties.

(5) Solution Explorer — The Solution Explorer lets you manage the files associated with the cur-
rent solution. For example, in Figure 1-1, you could select Form1.vb in the Project Explorer and
then click the View Code button (the icon third from the right at the top of the Solution Explorer)
to open the form’s code editor. You can also right-click an object in the Solution Explorer to get a
list of appropriate commands for that object.

(6) Properties — The Properties window lets you change an object’s properties at design time.
When you select an object in a form designer or in the Solution Explorer, the Properties window
displays that object’s properties. To change a property’s value, simply click the property and
enter the new value.

(7) Error List — The Error List window shows errors and warnings in the current project. For
example, if a variable is used and not declared, this list will say so.

If you look at the bottom of Figure 1-1, you'll notice that the Toolbox and Error List windows each have
a series of tabs. The Toolbox’s other tab displays the Document Outline window, which displays an out-
line view of a project showing its forms and components.

The Error List window’s Output tab shows output printed by the application. Usually an application
interacts with the user through its forms and dialogs, but it can display information here to help you
debug the code. The Output window also shows informational messages generated by the IDE. For
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example, when you compile an application, the IDE sends messages here to tell you what it is doing and
whether it succeeded.

The following sections describe the major pieces of the IDE in more detail.

Menus

The IDE’s menus contain standard Visual Studio commands. These are generally commands that manip-
ulate the project and the modules it contains. Some of the concepts are similar to those used by any
Windows application (File\New, File\Save, Help\Contents), but many of the details are specific to
Visual Studio programming, so the following sections describe them in a bit more detail.

The menus are customizable, so you can add, remove, and rearrange the menus and the items they con-
tain. This can be quite confusing, however, if you later need to find a command that you have removed
from its normal place in the menus. Some developers place extra commands in standard menus, particu-
larly the Tools menu, but it is generally risky to remove standard menu items. Usually it is safest to leave
the standard menus alone and make custom toolbars to hold customizations. For more information on
this, see the section “Customize” later in this chapter.

Many of the menus’ most useful commands are also available in other ways. Many provide shortcut key
combinations that make using them quick and easy. For example, Ctrl-N opens the New Project dialog
just as if you had selected the File\New Project menu command. If you find yourself using the same
command very frequently, look in the menu and learn its keyboard shortcut to save time later.

Many menu commands are also available in standard toolbars. For example, the Debug toolbar contains
many of the same commands that are in the Debug menu. If you use a set of menu commands fre-
quently, you may want to display the corresponding toolbar to make using the commands easier.

Visual Studio also provides many commands through context menus. For example, if you right-click on
a project in the Solution Explorer, the context menu includes an Add Reference command that displays
the Add Reference dialog just as if you had invoked Project\ Add Reference. Often it is easier to find a
command by right-clicking an object related to whatever you want to do than it is to wander through
the menus.

The following sections describe the general layout of the standard menus. You might want to open the
menus in Visual Studio as you read these sections, so you can follow along.

Note that Visual Studio displays different menus and different commands in menus depending on what
editor is active. For example, when you have a form open in the form editor, Visual Studio displays a
Format menu that you can use to arrange controls on the form. When you have a code editor open, the
Format menu is hidden because it doesn’t apply to code.

File
The File menu, shown in Figure 1-2, contains commands that deal with creating, opening, saving, and
closing projects and project files.
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Figure 1-2: The File menu holds commands that deal with the solution and its files.

Following is a description of the commands contained in the File menu and its submenus:

Qa

New — The New submenu shown in Figure 1-2 contains commands that let you create a new
Visual Basic project, Web site project (generally ASPNET or a Web Service), or file (text file,
bitmap, Visual Basic class, icon, and many others). The Project From Existing Code command cre-
ates a new project and puts all of the files in a directory in it, optionally including subdirectories.

New\File — The New submenu’s File command displays the dialog shown in Figure 1-3. The
IDE uses integrated editors to let you edit the new file. For example, the simple bitmap editor
lets you set a bitmap’s size, change its number of colors, and draw on it. When you close the file,
Visual Studio asks if you want to save the file and lets you decide where to put it. Note that this
doesn’t automatically add the file to your current project. You can save the file and use the
Project\ Add Existing Item command if you want to do so.

Open — The Open submenu contains commands that let you open a project or solution, Web
site, or file. The Convert command displays the Convert dialog shown in Figure 1-4. From this
dialog, you can launch the Visual Basic 2005 Upgrade Wizard, which can help you convert
Visual Basic 6 programs to Visual Basic 2005.

Close — This command closes the current editor. In Figure 1-2, Form1 is open in the form
designer editor. This command would close this editor.
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Converts a Visual Basic 6.0 project to a Visual Basic 2005 project

- Addto current solution

% Create new solution

0K I

Figure 1-4: The File\Open\Convert command displays this dialog
to help you convert Visual Basic 6 applications to Visual Basic 2005.

Close Project — This command closes the entire project and all of the files it contains. If you
have a solution open, this command is labeled Close Solution.

Save Form1.vb — This command saves the currently open file, in this example, Form1.vb.

Save Form1.vb As — This command lets you save the currently open file in a new file.

Save All — This command saves all modified files.

Export Template — This command displays the dialog shown in Figure 1-5. The Export Template
Wizard lets you create project or item templates that you can use later.
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Export Template Wizard I
I

=

Choose Template Type

This wizard will allow you to export a project or project item from the current solution to a template which
future projects can then be based upon,

YWhich type of ternplate would you like to create?
% Project template

A project template will allow 2 user to create a new project based on your exported project. A user will
be able to utilize your template from the Mew Project dialog box for client projects and from the Mew
Website dialog box for websites.

 ltem template

An itern template will allow a user to add your itern to one of their existing project. Your ternplate will be
available to the user fram the Add Mew ltermn dialog box.

Fram which project would you like to create a template?

iWindowsAppIicatiom ;I

What type of project or item does this templ

| ' B

Einish Cancel

Figure 1-5: The File\Export Template command displays this dialog to help you create project or
items templates that you can easily use in other projects.

Q  Page Setup and Print — The Page Setup and Print commands let you configure printer settings
and print the current document. These commands are enabled only when it makes sense to
print the current file. For example, if you are viewing a source code file or a configuration file
(which is XML text), you can use these commands. If you are viewing bitmap or a form in
design mode, these commands are disabled.

Q  Recent Files and Recent Projects — The Recent Files and Recent Projects submenus let you quickly
reopen files, projects, and solutions that you have opened recently.

Edit

The Edit menu, shown in Figure 1-6, contains commands that deal with manipulating text and other
objects. These include standard commands such as the Undo, Redo, Copy, Cut, and Paste commands
that you've seen in other Windows applications.

Following is a description of other commands associated with the Edit menu:

Q  Cycle Clipboard Ring — The clipboard ring contains the last several items that you copied into
the clipboard. This command copies the previous clipboard ring item to the current location.
By using this command repeatedly, you can cycle through the items until you find the one
you want.
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Figure 1-6: The Edit menu holds commands that deal with manipulating text and other objects.

a

Find and Replace\Quick Find — This command displays a find dialog where you can search the
project for specific text. A drop-down lets you indicate whether the search should include only
the current document, all open documents, the current project, or the entire solution. Options let
you determine such things as whether the text must match case or whole words.

Find and Replace\Quick Replace — This command displays the same dialog as the Quick except
with some extra controls. It includes a text box where you can specify replacement text, and but-
tons that let you replace the currently found text or all occurrences of the text.

Find and Replace\Find in Files — This command is similar to Quick Find except that it displays
its results as a list in a new window. Double-click on an entry in the list to view the occurrence
in its file.

Find and Replace\Replace in Files — This command is similar to Quick Replace except that it dis-
plays its results as a list in a new window.

Go To — This command lets you jump to a particular line number in the current file.

Advanced — The Advanced submenu contains commands for performing more complex docu-
ment formatting such as converting text to upper- or lowercase, controlling word wrap, and
commenting, and uncommenting code.
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Q

to the next or previous bookmark.

outlining on and off.

Bookmarks — The Bookmarks submenu lets you add, remove, and clear bookmarks, and move
Outlining — The Outlining submenu lets you expand or collapse sections of code, and turn

IntelliSense — The IntelliSense gives access to IntelliSense features. For example, its List

Members command makes IntelliSense display the current object’s properties, methods,
and events.

View

The View menu, shown in Figure 1-7, contains commands that let you hide or display different windows
and toolbars in the Visual Studio IDE.

@0 WindowsApplication1 - Microsoft Visual Studio

- |

o
]

Solution Explorer - Windo... - L X
&2 EF|EE S
_@ WindowsApplication1

=d| My Project
j Form1i.vb

_ﬂ Data Sources |L:'3 Solution Explorer

Properties ~ 4 X

Formid_Load Attributes =

Ell=

@

File Edit | View | Project Build Debug Data Tools Window Community Help
j - jii] '“;—I Code | i Debug ~ Any CPU
i3, G, | Bl Desioner w5 R,
F =
1+ General Open With... j I 7 Load j
“4  server Explorer Ctri+Al+S Pt =
L-‘E Solution Explorer Ctri+AR+L =
ub Forwl Load (ByWVal sender
[ Bookmark Window Ctrl+K, Ctri+W =
[ZL class view Ctri+Shift+C
'_=i Code Definition Window  Ctri+, Ctri+D L—
4 Object Browser Ctrl+Alt+J
4 Error List Ctri+, Ctri+E =
= owp Ctri+Ah+0 _,|_I
ﬁ Properties Window F4
<] Task List Crbel CrT [0 Messages
# Teolbox Ctri+AR-X Line | column__ | Project
Find Results
Other Windows
Toolbars
= Full Screen Shift+Alt+Enter
E Havigate Backward Ctrl+- | b
= ommand ... |[5] Output | =]immediate ...

Ready

[

Ln3 Col 3

Chb

INS 4

Figure 1-7: The View menu lets you show and hide IDE windows and toolbars.
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Following is a description of commands associated with the View menu:

a

Q

Code — The Code command opens the selected file in a code editor window. For example, to edit
a form’s code, you can click on the form in the Solution Explorer and then select View\Code.

Designer — The Designer command opens the selected file in a graphical editor if one is defined
for that type of file. For example, if the file is a form, Visual Studio opens it in a graphical form
editor. If the file is a class module or a code module, the View menu hides this command because
Visual Studio doesn’t have a graphical editor for those file types.

Open — Opents the selected item with its default editor.

Open With — Opens the selected item with an editor of your choosing. For example, you could
open a form’s code with a text editor.

Standard windows — The next several commands shown in Figure 1-7 display the standard IDE
windows Solution Explorer, Class View, Resource View, Server Explorer, Properties Window,
Bookmark Window, Object Browser, Toolbox, Start Page, and Property Manager. These com-
mands are handy if you have hidden one of the windows and want to get it back. The most use-
ful of these windows are described later in this chapter.

Web Browser — The Web Browser submenu lets you display and manage a Web Browser within
the IDE. When the Web Browser is visible, the IDE displays a Web toolbar that lets you enter a
URL, jump to one of your favorite links, or add the current page to your Web favorites. The Web
Browser is particular useful for debugging Web applications because it lets you see what Web
pages will look like before you publish them.

Other Windows — The Other Windows submenu lists other standard menus that are not listed
in the View menu itself. These include the Macro Explorer, Document Outline, Task List, Error
List, Command Window, Output, Code Definition Window, and Object Test Bench. It also
includes find results windows that list the results of searches you make using the Edit\Find and
Replace commands.

Tab Order — If a form contains controls, the Tab Order command displays the tab order on top
of each control. You can click on the controls in the order you want them to have to set their tab
order’s quickly and easily.

Toolbars — The Toolbars submenu lets you toggle the currently defined toolbars to hide or dis-
play them. This submenu lists the standard toolbars in addition to any custom toolbars you
have created.

Full Screen — The Full Screen command hides all toolbars and windows except for any editor
windows that you currently have open. It also hides the Windows taskbar so that the IDE occu-
pies as much space as possible. This gives you the most space possible for working with the files
you have open. The command adds a small box to the title bar containing a Full Screen button
that you can click to end full-screen mode.

Navigate Backward, Navigate Forward — These commands let you move back and forth through
the last several locations you visited.

Next Task, Previous Task — These commands move through the items in the Task List.

Property Pages — This command displays the current item’s property pages. For example, if you
select an application in Solution Explorer, this command displays the application’s property
pages similar to those shown in Figure 1-8.

11
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Figure 1-8: The View menu’s Property Pages command displays an application’s property pages.

Project

The Project menu shown in Figure 1-9 contains commands that let you add and remove items to and
from the project. Which commands are available depends on the currently selected item.

Following is a description of commands associated with the Project menu:

Q  New items — The first several commands let you add new items to the project. These com-
mands are fairly self-explanatory. For example, the Add Class command adds a new class mod-
ule to the project. Later chapters explain how to use each of these file types.

Q  Add New Item — The Add New Item command displays the dialog shown in Figure 1-10. The
dialog lets you select from a wide assortment of items such as text files, bitmap files, and class
modules.

Q  Add Existing Item — The Add Existing Item command lets you browse for a file and add it to
the project.

Q  Exclude From Project — This command removes the selected item from the project. Note that
this does not delete the item’s file; it just removes it from the project.

12
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Figure 1-9: The Project menu lets you add files and references to the currently selected project.
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Figure 1-10: The Project menu’s Add New Item command lets you add a wide variety of

items to the project.
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Show All Files — The Show All Files command makes Solution Explorer list files that are nor-
mally hidden. These include resource files corresponding to forms, hidden partial classes such
as designer-generated form code, resource files, and files in the obj and bin directories that are
automatically created by Visual Studio when it compiles your program. Normally, you don’t
need to work with these files, so they are hidden. Select this command to show them. Select the
command again to hide them.

Add Reference — The Add Reference command displays the dialog shown in Figure 1-11. Select
the category of the external object, class, or library that you want to find. For a .NET component,
select the .NET tab. For a Component Object Model (COM) component such as an ActiveX
library or control built using Visual Basic 6, select the COM tab. Select the Projects tab to add a
reference to another Visual Studio project. Click the Browse tab to manually locate the file you
want to reference.

Add Reference =
MET |COM | Projects | Elrowsel Recent |
Component Matme Wersion
a 0.
AzphlettddCExt 0a. w2
CppCodeProvider 00 w2
CrystalDecisions CrystalReports Engine 102360, w2
CrystalDecisions ReportSource 102360, w2
CrystalDecizions Shared 102360, w2
CrystalDecizions Wek 102360, w2
CrystalDecisions Windows Forms 102360, w2
cecompmgd 5000 w2
Cuztombarshalers 2000 w2
EnvDTE §.0.00 vl
envte §.o00 vl
EnvDTESD g.0.0.0 ] [
4 | 3
Ok | Cancel |

Figure 1-11: Use the Add Reference dialog to add references
to external libraries.

Scroll through the list of references until you find the one you want and select it. You can use
Shift-Click and Ctrl-Click to select more than one library at the same time. When you have
made your selections, click OK to add the references to the project. After you have added a ref-
erence to the project, your code can refer to the reference’s public objects. For example, if the file
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MyMathLibrary.dll defines a class named MathTools and that class defines a public function
Fibonacci, a project with a reference to this DLL could use the following code.

Dim math_tools As New MyMathLibrary.MathTools
MsgBox ("Fib(5) = " & math_tools.Fibonacci (5))

Q  Add Web Reference — The Add Web Reference command displays the dialog shown in Figure 1-12.

You can use this dialog to find Web Services and add references to them so your project can invoke
them across the Internet.

Q  WindowsApplication1 Properties — This command displays the application’s property pages
shown in Figure 1-13.

Add Web Reference

Mavigste to & wek service URL and click Add Reference to add all the available services.
@ @ B A
R | = e

ﬂ weh services found at this URL:

Start Browsing for Web Services |

g a5 8 Atarting oot Lo find Wel senices. Yoo can

wices in Lhis solution

s on Lh

S A et Wieh relErencE GEmE)

Add Reference |

ﬂ Cancel |

Y/

Figure 1-12: Use the Add Web Reference dialog to add references to Web Services.
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In Figure 1-13, the Toolbox, Solution Explorer, Properties window, Errors List, and other secondary win-
dows have been hidden to make more room for the large Properties page. You can see these other win-
dows’” icons lurking along the left, right, and bottom edges of the figure.

Click the tabs on the left to view and modify different types of application settings. You can leave many
of the property values alone and many are set in other ways. For example, by default, the Assembly
name and Root namespace values shown in Figure 1-13 are set to the name of the project when you first
create it.

There are three properties on the Compile tab shown in Figure 1-14 that deserve special mention.

First, Option Explicit determines whether Visual Basic requires you to declare all variables before using
them. Leaving this option turned off can sometimes lead to subtle bugs. For example, the following code
is intended to print a list of even numbers between 0 and 10. Unfortunately, a typographical error makes
the Debug . WriteLine statement print the value of the variable j not i. Because j is never initialized, the
code prints out a bunch of blank values. If you set Option Strict to On, the compiler complains that the
variable j is not declared and the problem is easy to fix.

For i = 1 To 10
If 1 Mod 2 = 0 Then Debug.WriteLine(3j)

Next i
20 WindowsApplication1 - Microsoft Visual Studio
File Edit View Project Build Debug Data Tools Window Community Help
- W g X B R |9 -5 -E | b Debug = Any CPU = | 2% ;E:
; ~WindowsApplication1 | Form1.ub* | Form1.ub [Design]’ | * X E
T (|
el =
g &
= Application @
i Configuration: |II-A j Platform: III-A j o
Compile i
Debug Assembly name: Root namespace: =1 ?';_u
ndowsApplication1 I\!\ﬁn(lows.ﬂ.pplicatimﬂ 2
References g-
Application type: lcon: =
m
Resources IWin(Iows Application j I{Default Icon) L’ E é
=3
Settings Startup form: i
IForm1 j Assembly Information... | mH
Signing I—%
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1 [v Enable application framework — =
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=
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.-\""'w-___ [~ Make single instance application
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4| | 3
|_3 Error List| ] Task Lis‘t|>_‘| Conlmnll(lWilldow|j Ompmhj Immediate Window
Ready 4

Figure 1-13: Property pages let you set a project’s properties.
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Figure 1-14: The Compile tab contains important properties for controlling code generation.

The second compiler option is Option Strict. When this option is turned off, Visual Studio allows your
code to implicitly convert from one data type to another, even if the types are not always compatible. For
example, Visual Basic will allow the following code to try to copy the string s into the integer i. If the
value in the string happens to be a number, as in the first case, this works. If the string is not a number,
as in the second case, this fails at run time.

Dim i As Integer

Dim s As String

s = "10"

= s ' This works.
= "Hello"

= s ' This Fails.

SRR

If you set Option Strict to On, the IDE warns you that the two data types are incompatible, so you can
easily resolve the problem while you are writing the code. You can still use conversion functions such as
CInt, Int, and Integer.Parse to convert a string into an Integer, but you must take explicit action to
do so. This makes you think about the code and reduces the chances that the conversion is just an acci-
dent. This also helps you use the correct data types and avoid unnecessary conversions that may make
your program slower.

17
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To avoid confusion and long debugging sessions, you should always set Option Explicit On and Option
Strict On. You can turn them on for a project using the project page. To make them on by default for new
projects, open the Tools menu and select Options. Open the Projects and Solutions folder, select the VB
Defaults page, and turn the options on, as shown in Figure 1-15.

Options 2]
;I Default project settings:
Option Explicit: on s
Option Strict: on -

Option Compare: IElinary i I

i e WiT++ Project Settings
- Snurre Conteol Ll

Ok I Cancel

Figure 1-15: The Projects and Solutions folder’'s VB Defaults page lets you set default
values for Option Explicit and Option Strict.

The final compiler directive, Option Compare, can take the values Binary or Text. If you set Option
Compare to Binary, Visual Basic compares strings using their binary representations. If you set Option
Compare to Text, Visual Basic compares strings using a case-insensitive method that depends on your
computer’s localization settings. Option Compare Binary is faster, but may not always produce the
result you want.

If you select a solution and then invoke the Project menu’s Properties command, Visual Studio displays
the Solution Properties Pages dialog shown in Figure 1-16. Select an item on the left to view, and modify
the corresponding values on the right.

Build

18

The Build menu, shown in Figure 1-17, contains commands that let you compile projects within a
solution.
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Figure 1-16. The Solution Properties Pages dialog lets you set solution properties.
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Figure 1-17: The Build menu lets you compile projects. 19
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Following is a description of commands associated with the Build menu:

20

a

Build WindowsApplication] — This command compiles the currently selected project, in this case
the project WindowsApplicationl. Visual Studio examines the project’s files to see if any have
changed since the last time it compiled the project. If any of the files have changed, Visual
Studio recompiles those files to update the result.

Rebuild WindowsApplication] — This command recompiles the currently selected project from
scratch. The Build WindowsApplicationl command compiles only the files that you have modified
since they were last built. This command rebuilds every file.

Clean WindowsApplication] — This command removes temporary and intermediate files that
were created while building the application, leaving only the source files and the final result
.exe and .dll files.

Publish WindowsApplicationl — This command displays the Publish Wizard shown in Figure

1-18. It can walk you through the process of making your application available for distribution
on a local file, file share, FTP site, or Web site.

Publish Wizard =1x|

Where do you want to publish the application? ?

Specify the location to publizh this application:

kit iy vb-helper comavindows A pplicationd § Brovwese... |

*fou may publish the spplication to & wek site, FTP server, or file psth.

Examples:
Disk path: cHideployimyspplication
File share: zerverimyapplication
FTP server:  fpoifftp microsoft cominyapplication
Wk site: hittp: Mhesiese microsoft.comimyspplicstion

Previous | Hext > I Finish Cancel

Figure 1-18: The Publish Wizard helps you deploy an application.

Configuration Manager — The Configuration Manager command displays the dialog shown in
Figure 1-19. You can use this dialog to indicate the type of build you want to use for each project
(debug or release), and the platforms you want to target (for example Itanium, x64, or x86). You
can also use the Build check boxes shown in the figure to determine which projects get built.
You can use this feature to skip compilation of some projects within the solution. If you find that
some parts of a solution are not compiling, check the Configuration Manager.
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Figure 1-19: The Configuration Manager lets you manage project builds.

Release configurations use more optimizations than Debug configurations, so they provide smaller,

faster executable programs. They do not include support for debugging, however, so you cannot debug
a program compiled for release.

In the “Active solution configuration” drop-down, select the <New...> entry to create a new configura-
tion. When you select this entry, Visual Studio displays the New Solution Configuration dialog shown in
Figure 1-20. Enter the name you want to give the configuration, select the existing configuration from
which it should copy default values, and click OK.

Copy settings from:

|<Ernp1y=

¥ Create new project configurations

Ok I Cancel |

Figure 1-20: The New Solution Configuration dialog

lets you create new configurations.

The “Active solution configuration” drop-down also contains an item labeled <Edit...>. If you select this
entry, Visual Studio displays a dialog where you can rename or remove configurations.
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Use the drop-downs and check boxes in the grid to select features for the solution’s projects. For exam-
ple, if the solution contains several projects, you could flag some to compile using the Debug configura-
tion and others to compile using the Release configuration. If you then rebuilt the solution, you would
be able to debug some of the projects but not all of them. This approach may be useful if you want to
give some of the projects to customers in their release versions while you keep working on others.

If you uncheck a project’s Build box, that project is excluded from any builds. If you build the solution, it
is not compiled. Visual Studio writes its results into the Output window and counts the skipped project
in its final summary line. The following line shows an example where one project was compiled and one
skipped.

========== Build: 1 succeeded or up-to-date, 0 failed, 1 skipped ==========

Debug

22

The Debug menu, shown in Figure 1-21, contains commands that help you debug a program. These
commands help you run the program in the debugger, move through the code, set and clear breakpoints,
and generally follow the code’s execution to see what it’s doing and hopefully what it’s doing wrong.

#0WindowsApplication1 (Debugging) - Microsoft Visual Studio Hi[=] 3 I
File Edit View Project Build | Debug | Tools Window Community Help
(- @ | & 2y Windows ¥ |[J Breakpoints  CtrAl:B | i
Py omo@m @ o &= LE 2= |y P Continue F5 =] Output
: Ay | .
: __:l Wy %5 A : ; -2 (1] _ﬂp Script Explorer  Ctri+AR+H
e Stop Debuggin Shift+F5 =1
X /’FOlmLuh | Form1.ub [Design] a@ ; aging VWatch » - X [;‘_h
Detach All =
§ [ (Form1 Events) & Autos Ctrl+Al+V, A ﬁ' 5
= = < =z 1]
g 10 ic Class Formi Terminate All 72 Locals Ctri+Al+V, L s
3 ;! o -
e il Restart Ctrl+Shift+F5 £1 Immediate Ctrl+Alt+ Tl 3
= L entlirgs 3
5k Attachto Process... & Call Stack Ctrl+AR+C gsiple |
Exceptions... Ctri+Al+E 2} Threads Ctrl+Alt+H —— AI'J
= W
*E  Step Into F11 “ Modules Ctri+an-+U &
i =
L= step Over F10 | Processes Ctrl+Alt+Z = 1=
2= Step Out Shift+F11 | s
& QuickWatoh.. cutar-o [ =
Show output from: Debug Teggle Breakpoint 9 ]
Iﬂ:!.ndows)\.ppl:!.cat.:!.onl .wshos Hew Breakpoint » assemblyh GAC_MEILY System DeploymentiZ. 0 & L%
'Windowsdpplicationl. wshos pssemblyl GAC _MEILY System X¥nliZ2 0. 0.0_ k' -l
'WindowsApplicationl. wshos XJ Delete All Breakpoeints  Ctrl+Shift+F9 assembly' GAC_MEILVMicrosoft. VisualBasic %
H 2
The thread OxeZc has exite = = =-
The thread '<No Hames' {0x ) Disable All Breakpoints a
'‘WindowsApplicationl. wshost _ exe' (Managed): Loaded 'C:WVE Prog RefyJulyCTPSrcoiChOlyWindowsdpplicationl’
'Windowshpplicationl wshost. exe' (Managed): Loaded 'C:AWINDOWShassembly'\GAC_MSILY System. Puntime. Remotil
=
4| | 3
] Command Window |—immediate Window | 7 Bookmarks | 7 Error List Lj Output |
Ready Ln3 Col 5 Ch 5 INS 4

Figure 1-21: The Debug menu contains commands for debugging an application.
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Effectively using these debugging techniques can make finding problems in the code much easier, so
you should spend some time learning how to use these tools. They can mean the difference between
finding a tricky error in minute, hours, or days.

The commands visible in the Debug window change, depending on several conditions such as the type
of file you have open, whether the program is running, the line of code that contains the cursor, and
whether that line contains a breakpoint. This section discusses the menu items shown in Figure 1-21.
You will see other menus items under different circumstances.

The following list briefly describes the Debug menu’s commands.

a

a

o

Windows — This submenu’s commands display other debugging-related windows. This sub-
menu is described in more detail in the following section, “The Debug\Windows Submenu.”

Continue — This command resumes program execution. The program runs until it finishes, it
reaches another breakpoint, or you stop it.

Break All — This command stops execution of all programs running within the debugger. This
may include more than one program if you are debugging more than one application at the
same time. This can be useful, for example, if two programs work closely together.

Stop Debugging — This command halts the program’s execution and ends its debugging ses-
sion. The program stops immediately, so it does not get a chance to execute any cleanup code.

Detach All — This command detaches the debugger from any processes to which it is attached.
Note that this does not stop those processes.

Terminate All — This command terminates any processes to which the debugger is attached.
Restart — This command stops the currently running process and restarts the startup project.

Attach to Process — This command displays the dialog shown in Figure 1-22 to let you attach
the debugger to a running process. Select the process to which you want to attach and click
Attach.

Exceptions — This command displays the dialog shown in Figure 1-23. If you check a Thrown
box, the debugger stops whenever the selected type of error occurs. If you check a User-
unhandled box, the debugger stops when the selected type of error occurs and the program
does not catch it with error handling code. For example, suppose that your code calls a sub-
routine that causes a divide-by-zero exception. Use the dialog to select Common Language
Runtime Exceptions/System/System.DivideByZeroException (use the Find button to find it
quickly). If you check the Thrown box, the debugger stops in the subroutine when the divide-
by-zero exception occurs even if the code is contained in an error handler. If you check the User-
unhandled box, the debugger stops only if no error handler is active when the error occurs.
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Figure 1-22: The Attach to Process dialog lets you attach the debugger to running processes.

Break when an exception is:

EgC++ Exceptions

[+- Common Language Runtime Exceptions
g d Debugging
Hative Run-Time Checks
[+]-Win32 Exceptions

Figure 1-23: The Exceptions dialog lets you determine how Visual Basic handles
uncaught exceptions.
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Step Into — This command makes the debugger execute the current line of code. If that code
invokes a function, subroutine, or some other procedure, the point of execution moves into that
procedure. It is not always obvious whether a line of code invokes a procedure. For example, a
line of code that sets an object’s property may be simply setting a value or invoking a property
procedure.

Step Over — This command makes the debugger execute the current line of code. If that code
invokes a function, subroutine, or some other procedure, the debugger calls that routine but
does not step into it, so you don’t need to step through its code. However, if a breakpoint is set
inside that routine, execution will stop at the breakpoint.

Step Out — This command makes the debugger run until it leaves the routine it is currently
executing. Execution pauses when the program reaches the line of code that called this routine.

QuickWatch — This command displays a dialog that gives information about the selected code
object. Figure 1-24 shows the dialog displaying information about a TextBox control named
txtDirectory. If you look closely, you can see some of the control’s properties including
TabIndex, TabStop, Tag, and Text.

QuickWatch =]
Expression;
| txtDirectory.TextLength ‘d

Add Watch |
Walue:
| Hame Value | Tvpe ;I
— 5 TahIndex i] Integer
— [ TahStop True Boolean
— i Tag Maothing Ohject
— o Teut 3, = String
— 9 Text 3, = String
— o text Mothing 2 = String
— ¢ textalign Left 40% Syskern. Window
— _*%" Textalign Left fak- Syskerm, Window
—H 4 textBoxFlags Mothing Syskem. Collectic
g Testengn o e ]
— & threadCallbackMessage o Integer
— @' Top 16 Integer = |
—# 8 ToplLevelControl {windowsapplicationl.Farml} Syskern. Window
—F]_ A Trnl ewelCankrolTnkermal Swindmws aAnnlicatinn 1. Form1 + Swstermn  findnu
Cloze | Help |

Figure 1-24: The QuickWatch dialog lets you examine an object’s properties
and optionally set a new watch on it.

If you double-click on a property’s value, you can change it within the dialog. If you click the
Add Watch button, the debugger adds the expression to the Watch window shown in Figure 1-25.
You can also highlight a variable’s name in the code and drag and drop it into a Watch window
to create a watch very quickly. Right-click a watch in this window and select Delete Watch to
remove it.
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_|Hame | Value | Type
e bxtDirectory, Texk
xtDirector 4

% = Skring

Left {0} s.Forms, Harizontalslignment

Figure 1-25: The Watch window lets you easily track expression values.

Toggle Breakpoint — This command toggles whether the current code line contains a breakpoint.
When execution reaches a line with an active breakpoint, execution pauses so you can examine
the code and program variables. You can also toggle a line’s breakpoint by clicking on the mar-
gin to the left of the line in the code editor. In Figure 1-21, line number 4 displays a circle con-
taining an arrow on the left, indicating that it has a breakpoint (the circle) and that it is the
current line of execution (the arrow). The following line also contains a breakpoint, and line 7
contains a disabled breakpoint, indicated by a hollow circle in the left margin.

New Breakpoint — This submenu contains the Break At Function command. This command dis-
plays a dialog that lets you specify a function where the program should break.

Delete All Breakpoints — This command removes all breakpoints from the entire solution.

Enable All Breakpoints — This command reenables any disabled breakpoints. The Enable All
Breakpoints command is available if any breakpoints are currently disabled. Note that you can
right-click a line of code that contains a disabled breakpoint and select Enable Breakpoint to
enable only that breakpoint.

Disable All Breakpoints — This command temporarily disables all the solution’s breakpoints. The
breakpoints are still defined but they don’t interrupt the program’s execution. The Disable All
Breakpoints command is available if any breakpoints are currently enabled. Note that you can
right-click a line of code that contains a breakpoint and select Disable Breakpoint to disable only
that breakpoint.

The Debug\Windows Submenu

The Debug menu’s Windows submenu, shown in Figure 1-26, contains commands that display debugging-
related windows. The following list briefly describes these commands. The two sections that follow
describe some of the more complicated windows in greater detail.

26
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Breakpoints — This command displays the Breakpoints window shown in Figure 1-27. This dia-
log shows the breakpoints, their locations, and their conditions. Check or uncheck the boxes on
the left to enable or disable breakpoints. Right-click a breakpoint to edit its location, condition,
hit count, and action. Use the dialog’s toolbar to create a new function breakpoint, delete a
breakpoint, delete all breakpoints, enable or disable all breakpoints, go to a breakpoint’s source
code, and change the columns displayed by the dialog. Right-click on a breakpoint to change its
condition (a condition that determines whether the breakpoint is activated), hit count (a count
that determines whether the breakpoint is activated), and “When Hit” (action to take when acti-
vated). See the section “The Breakpoints Window” later in this chapter for more detail.
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Figure 1-26: The Debug menu’s Windows submenu contains commands that display debugging-related
windows.

Columns ~

| condition | Hit Count | Address |

S JFormi.vb, line 3 character 5 QRULESLLLLTT] break always (currently 0) WindowsApplication1.Form1.Form1_Load({Object, 5...
- D .} Formiwh, line 4 character 9  (no condition) break always (currently 0) WindowsApplication1.Form1.Form_Load(Object, 5...

J Formd.vh, line 5 character 5 (no condition) break always (currently 0) WindowsApplication1.Form1.Formi_Load(Object, 5...

Figure 1-27: The Breakpoints window helps you manage breakpoints.

Q  Output — This command displays the Output window. This window displays compilation
results and output produced by Debug and Trace statements.

Q  Script Explorer — This command displays the Script Explorer, which can help you debug script
code written in VBScript or JScript.

Q  Watch — The Watch submenu contains the commands Watch 1, Watch 2, Watch 3, and Watch 4.
These commands display four different watch windows. When you create a watch using the
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Debug menu’s QuickWatch command described earlier, the new watch is placed in the Watch 1
window (shown in Figure 1-25). You can click and drag watches from one watch window to
another to make a copy of the watch in the second window. You can also click on the Name col-
umn in the empty line at the bottom of a watch window and enter an expression to watch. One
useful IDE trick is to drag watch windows 2, 3, and 4 onto Watch 1 so that they all become tabs
on the same window. Then you can easily use the tabs to group and examine four sets of watches.

Autos — This command displays the Autos window shown in Figure 1-28. This window dis-
plays the values of local and global variables used in the current line of code and in the three
lines before and after it.

| name | value | Type =
e o nem
Wi 10 Inkeger
[# (3 bxtDirectory Texk="" System.Windows.Forms . TextBox
i bxtDirectory. Text 2, String
@ X 150.0 Single
Py 0.0 Single

Figure 1-28: The Autos window displays the variables used
in the current code statement and the three statements
before and the three after.

Locals — This command displays the Locals window shown in Figure 1-29. The Locals window
displays the values of variables defined in the local context. To change a value, click on it and
enter the new value. Click the plus and minus signs to the left of a value to expand or collapse
it. For example, the Me entry shown in Figure 1-29 is an object with lots of properties that have
their own values. Click the plus sign to expand the object’s entry and view its properties. Those
properties may also be objects, so you may be able to expand them further.

Locals [ =] I
J Nam_e Value _4 Type _3

{windowsapplicationl Form1} '-.-'-.-'irun:ln:nl.-'-.l-_:ﬁ|:||:nlin:atiFn:nrrnl
v e {Systern . Eventargsh Systern.Eventhrgs

@i 10 Integer

o i 10 Integer
H ¢ sender {windowsApplicationl .Farml} Object

@ x 150.0 Single

Wy 0.0 Single

i
Figure 1-29: The Locals window displays the values of variables
defined in the local context.

Immediate — This command displays the Inmediate window, where you can type and execute
ad hoc Visual Basic statements. The section “The Command and Immediate Windows” later in
this chapter describes this window in a bit more detail.

Call Stack — This command displays the Call Stack window shown in Figure 1-30. This win-
dow lists the routines that have called other routines to reach the program’s current point of
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execution. In this example, the program is at the line 20 in function SearchDatabase. That
function was called by function FindEmployee at line 17, and that function was called by the
Form_Load event handler. Double-click on a line to jump to the corresponding code in the pro-
gram’s call stack. This technique lets you move up the call stack to examine the code that called
the routines that are running. This can be a very effective technique when you need to find out
what code is calling a particular routine.

| Call Stack B

| Hame | Language —

Windowsapplicati IWindowsApplication3 . Forml, SearchDatabase() Line 20 + 0x5 bytes
windowsapplication3, EXE!'Windows Application3.Form . FindEmployes() Line 17 + 0x9 bytes Basic
windowsapplicationd, EXElWindowsApplication3.Form1 . Forml_Load{Object sender = {Windowsapplication. Formi1}, Syster Basic

[External Code]

]

Figure 1-30: The Call Stack window shows which routines have called which to get to the
program’s current point of execution.

Threads — This command displays the Threads window shown in Figure 1-31. A thread is a sep-
arate execution path that is running. A multithreaded application can have several threads run-
ning to perform more than one task at the same time. The Threads window lets you control the
threads’ priority and suspended status. The last line has the location WindowsApplicationl
.Forml.SearchDatabase, indicating that this thread is executing the SearchDatabase rou-
tine in the Form1 module in program windowsApplicationl. The arrow on the left indicates
that this is the currently active thread.

|
| 1] | Hame | Location | Priority | Suspend
3580 1]
1260 <Mo Name = Highest 1]
1292 Mo Mame= Mormal a
3664 <Mo Mame:= Mormal a
2064 Mo Mame = Marmal 0
1892 Mo Mame:= Mormal a
2392 <Mo Mame = Mormal 0
4068 <Mo Mame > Windowsapplication3.Form1 . SearchDatabase _

Figure 1-31: The Threads window displays information about the program’s
threads of execution.

Right-click a thread and select Freeze to suspend it. Select Thaw to make it resume execution.
Double-click a thread or right-click it and select Switch To Thread to activate that thread.

Modules — This command displays the Modules window shown in Figure 1-32. This window
displays information about the DLL and EXE files used by the program. It shows each module’s
file name and path. It indicates whether the module is optimized, whether it is your code (ver-
sus an installed library), and whether debugging symbols are loaded. Scrolled off the right edge
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of Figure 1-32, the window shows each module’s load order (lower-numbered modules are
loaded first), the module’s version, timestamp, and the process using the module. Click on a col-
umn to sort the modules by that column.

Modules
Hame Path Optimized | User Code | Symbol Status
j mscorlib.dil C:WIHDOWS'\assembly'\GAC_32'mscorlib'2.0.0... Yes Ho Skipped loading...
ﬂ Microsoft.VisualStudio.HostingP... C:WIHDOWS'\assembh/\GAC_MSIL' Microsoft.... Yes Ho Skipped loading...
4] SystemWindows.Forms.dil C:WINDOWS assembly'\GAC_MSIL'SystemWi... Yes Ho Skipped loading...
ﬂ System.dil C:WINDOWSassemblhy\GAC_MSIL \System'2.0... Yes Ho Skipped loading...
g] System.Drawing.dll C:WIHDOWS \assembhy/\GAC_MSIL'System.Dr... Yes Ho Skipped loading...
ﬂ Microsoft.VisualStudio.HostingP... C:WIHDOWS\assembly'\GAC_MSIL'Microsoft.... Yes Ho Skipped loading...
ﬂ WindowsApplication1.vshost.exe C:\WB Prog Ref\CeSrc\ChiMM'WindowsApplicati... Yes Ho Skipped loading...
4 system.Deployment.dil C:WIHDOWS \assembhy/\GAC_MSIL'System.De... Yes Ho Skipped loading...
ﬂ Microsoft.VisualBasic.dll C:WIHDOWS ‘assembly ' GAC_MSIL'Microsoft.... Yes Ho Skipped loading...
@ WindowsApplication1.EXE C:\WB Prog Ref\CeSrc\Chi1'WindowsApplicati... Symbols loaded.
ﬂ System.Runtime.Remoting.dil C:WINDOWS assembly'GAC_MSIL'System.Ru... Yes Ho Skipped loading...
B B

Figure 1-32: The Modules window displays information about the modules used by the program.

Q  Processes — This window lists processes that are attached to the Visual Studio session. This
includes any programs launched by Visual Studio and processes that you attached to using the
Debug menu’s Attach to Process command.

e Breakpoints Window

A breakpoint is a line of code that you have flagged to stop execution. When the program reaches that
line, execution stops and Visual Studio displays the code in a code editor window. This lets you examine
or set variables, see which routine called the one containing the code, and otherwise try to figure out
what the code is doing.

The Breakpoints window lists all the breakpoints you have defined for the program. This is useful for
a couple of reasons. First, if you define a lot of breakpoints, it can be hard to find them all later. While
other commands let you disable, enable, or remove all of the breakpoints at once, there are times when
you may need to find a particular breakpoint.

A common debugging strategy is to comment out broken code, add new code, and set a breakpoint near
the modification so that you can see how the new code works. When you have finished testing the code,
you probably want to remove either the old or new code, so you don’t want to blindly remove all of the
program’s breakpoints. The Breakpoints window lists all of the breakpoints and, if you double-click a
breakpoint in the list, you can easily jump to the code that holds it.

The Breakpoints window also lets you modify the breakpoints you have defined. Check or uncheck the
boxes on the left to enable or disable breakpoints. Use the dialog’s toolbar to enable or disable all break-
points, clear all breakpoints, or jump to a breakpoint’s source code.

Right-click a breakpoint and select Condition to display the dialog shown in Figure 1-33. By default, a
breakpoint stops execution whenever it is reached. You can use this dialog to add an additional condi-
tion that determines whether the breakpoint activates when reached. In this example, the breakpoint
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stops execution only if the expression (i = j) And (i > 20) is True when the code reaches the break-
point. Note that specifying a breakpoint condition can slow execution considerably.

when the breskpoint location is reached, the expression is evalusted and the
breakpoint is hit only if the expression is true or has changed.

¥ Condition:
| =0 And i = 20)

i+ |z trus
i Has chanoed

Ok I Cancel

Figure 1-33: The Breakpoint Condition dialog lets you
specify a condition that determines whether Visual
Studio stops at the breakpoint.

Right-click a breakpoint and select Hit Count to display the Breakpoint Hit Count dialog shown in
Figure 1-34. Each time the code reaches a breakpoint, it increments the breakpoint’s hit count. You can
use this dialog to make the breakpoint’s activation depend on the hit count’s value.

Breakpoint Hit Count

& breakpoint is hit when the breskpoint locstion is reached and the condition
iz zatisfied. The hit count is the numker of times the breakpoirt has been hit.

vihen the breskpoint is hit:

Current hit count: a

Reset | Ok I Cancel |

Figure 1-34: The Breakpoint Hit Count dialog lets you
make a breakpoint’s activation depend on the number
of times the code has reached it.

From the drop-down list you can select the options “break always,” “break when the hit count is equal
to,” “break when the hit count is a multiple of,” or “break when the hit count is greater than or equal to.”
If you select any but the first option, you can enter a value in the text box and the program will pause
execution when the breakpoint has been reached the appropriate number of times. For example, if you
select the option “break when the hit count is a multiple of” and enter “2” into the text box, then execu-
tion will pause every other time it reaches the breakpoint.

Right-click a breakpoint and select When Hit to display the When Breakpoint Is Hit dialog shown in
Figure 1-35. This dialog lets you specify the actions that Visual Basic takes when the breakpoint is acti-
vated. Check the “Print a message” box to make the program display a message in the Output window.
Check the “Run a macro” box to make the program execute a VBA macro. Check the “Continue execu-
tion” box to make the program continue running without stopping.
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When Breakp Is Hit

Specify what to do when the breakpoint is hit.
v Print & message:
IFunCtiDn: FFUMCTION, Thread: $TID $TMAME

'ou can include the value of a variable or other expresszion in the message by
placing it in curly braces, such as "The value of x is {x}." To insert a curly brace,
uze "W To insert & backslazh, use "0

The followving special keywords will be replaced with their current values:
$ADDRESS - Current Instruction, FCALLER - Previous Function Name,
FCOLLSTACK - Call Stack, $FURCTION - Current Function Mame,

FPID - Process ld, $PNAME - Process Name

FTID - Thresd Id, $TMNAME - Thread Mame

¥ Run a macro;

v Cortinue execution

Ok I Cancel

Figure 1-35: The When Breakpoint Is Hit Condition dialog
lets you determine what actions Visual Basic takes when
the breakpoint is activated.

e Command and Immediate Windows

The Command and Immediate windows both allow you to execute commands while the program is
stopped in the debugger. One of the more useful commands in each of these windows is the Debug . Print
statement. For example, the command Debug. Print x displays the value of the variable x.

You can use a question mark as an abbreviation for Debug . Print. The following text shows how the
command might appear in the Command window. Here the > symbol is the command prompt provided
by the window and 123 is the result: the value of variable x. In the Inmediate window, the statement
would not include the “>" character.

>? X

123

The command >immed tells the Command window to open the Immediate window. Conversely, the
command >cmd tells the Immediate window to open the Command window.

While there is some overlap between these two windows, they serve two mostly different purposes. The
Command window can issue commands to the Visual Studio IDE. Typically, these are commands that
appear in menus or toolbars, or that could appear in menus and toolbars. For example, the following
command uses the Debug menu’s QuickWatch command to open a QuickWatch window for the vari-
able first_name.

>Debug.QuickWatch first_name
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One particularly useful command is Tools.Alias. This command lists command aliases defined by
the IDE. For example, it indicates that ? is the alias for Debug. Print and that 22 is the alias for Debug
.QuickWatch.

The Command window includes some IntelliSense support. If you type the name of a menu, for exam-
ple Debug or Tools, IntelliSense will display the commands available within that menu.

While the Command window issues commands to the IDE, the Immediate window executes Visual Basic
statements. For example, suppose that you have written a subroutine named CheckPrinter. Then the
following statement in the Immediate window executes that subroutine.

CheckPrinter

Executing subroutines in the Immediate window lets you quickly and easily test routines without writ-
ing user interface code to handle all possible situations. You can call a subroutine or function, passing it
different parameters to see what happens. If you set breakpoints within the routine, the debugger will
pause there.

Similarly, you can also set the values of global variables and then call routines that use them. The follow-
ing Immediate window commands set the value of the m_PrinterName variable and then calls the
CheckPrinter subroutine.

m_PrinterName = "LP_REMOTE"
CheckPrinter

You can execute much more complex statements in the Command and Intermediate windows. For exam-
ple, suppose that your program uses the following statement to open a file for reading.

Dim fs As FileStream = File.OpenRead( _
"C:\Program Files\Customer Orders\Summary" & _
datetime.Now () .ToString ("yymmdd") & ".dat")

Suppose that the program is failing because some other part of the program is deleting the file. You can
type the following code (all on one line) into the Immediate window to see if the file exists. As you step
through different pieces of the code, you can use this statement again to see if the file has been deleted.

?System.I0.File.Exists("C:\Program Files\Customer Orders\Summary" & _
DateTime.Now () .ToString ("yymmdd") & ".dat")

The window evaluates the complicated string expression to produce a file name. It then uses the
System.IO.File.Exists command to determine whether the file exists and displays True or False
accordingly.

Data

The Data menu, shown in Figure 1-36, contains commands that deal with data and data sources. Some of
the commands in this menu are only visible and enabled if you are designing a form and that form con-
tains the proper data objects.
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Figure 1-36: The Data menu holds commands that deal with datasets.

The following list describes commands shown in Figure 1-36:

a

Show Data Sources — This command displays the Data Sources window, where you can work
with the program’s data sources. For example, you can drag and drop tables and fields from this
window onto a form to create controls bound to the data.

Preview Data — This command displays a dialog that lets you load data into a DataSet and
view it at design time.

Add New Data Source — This command displays the Data Source Configuration Wizard, which
walks you through the process of adding a data source to the project.

Add Query — This command is available when you are designing a form and have selected a
data bound control such as a DataGridview or bound TextBox. This command opens a dialog
where you can specify a query to add to the form. This places a ToolStrip on the form contain-
ing TooStripButton that populates the bound control by executing the query.

Format

The Format menu, shown in Figure 1-37, contains commands that arrange controls on a form. The fol-
lowing list describes the Format menu’s submenus:
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Figure 1-37: The Format menu contains commands for formatting and arranging controls on a form.

a

Align — This submenu contains commands that align the controls you have selected in various
ways. It contains the commands Lefts, Centers, Rights, Tops, Middles, Bottoms, and “to Grid.”
For example, the Lefts command aligns the controls so their left edges line up nicely. The “to
Grid” command snaps the controls to the nearest grid position. This is useful if you have moved
some controls off of the alignment grid, possibly by using one of the other Align commands or
by changing a control’s Location property in the Properties window.

Make Same Size — This submenu contains commands that change the size of the controls you
have selected. It contains the commands Width, Height, Both, and “Size to Grid.” The “Size to
Grid” command adjusts the selected controls” widths so that they are a multiple of the align-
ment grid size. The other commands give the selected controls the same width, height, or both.

Horizontal Spacing — This submenu contains commands that change the spacing between the
controls you have selected. It contains the commands Make Equal, Increase, Decrease, and
Remove. For example, if you have selected three controls, the Make Equal command makes
the spacing between the first two the same as the spacing between the second two. This can be
handy for making columns that line up nicely.

Vertical Spacing — This submenu contains the same commands as the Horizontal Spacing sub-
menu except it adjusts the controls’ vertical spacing rather than their horizontal spacing.
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Q  Center in Form — This submenu contains commands that center the selected controls on the
form. It contains the commands Horizontally and Vertically. Note that the selected controls are

centered as a group; they are not centered individually on top of each other.

Order — This submenu contains the commands Bring to Front and Send to Back, which move
the selected controls to the top or bottom of the stacking order.

Lock Controls — This command locks all of the controls on the form so that they cannot be
moved or resized by clicking and dragging. You can still move and resize the controls by chang-
ing their Location and Size properties in the Properties window. Invoking this command again
unlocks the controls. Locking the controls can be useful if you have spent a long time position-
ing them precisely. After they are locked, you can work on the controls without fear of acciden-
tally messing up your careful design.

Tools

The Tools menu, shown in Figure 1-38, contains miscellaneous tools that do not fit particularly well in
the other menus. It also contains a few duplicates of commands in other menus and commands that
modify the IDE itself.
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= & S| o | S 4]] Rl o | ope M oe 5 Connect to Device... 43 L
S0 | Formtub [Designt| #1, connectto Database... lorer -Windo... ~ 1 X
A E Connect to Server... j =.E ‘fl.
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Figure 1-38: The Tools menu contains miscellaneous commands and commands that modify the IDE.
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The following list describes the Tools menu’s most useful commands:

a

Q

Attach to Process — This command displays the dialog shown in Figure 1-22 to let you attach the
debugger to a running process. Select the process to which you want to attach and click Attach.

Connect to Device — This command lets you connect to a physical device or emulator such as
Pocket PC or Smartphone devices or emulators. You can use the devices and emulators to test
software you are writing for devices other than the Windows platform where you are building
the application.

Connect to Database — This command displays the Connection Properties dialog, where you
can define a database connection. The connection is added to the Server Explorer window.
You can later use the connection to define data adapters and other objects that use a database
connection.

Code Snippets Manager — This command displays the Code Snippets Manager, which you can
use to add and remove code snippets.

Choose Toolbox Items — This command displays a dialog that lets you select the tools displayed
in the Toolbox. For instance, by default the 01eDbDataAdapater and 0OleDbConnection com-
ponents are not included in the Toolbox. You can use this command to add them if you will use
them frequently.

Add-in Manager — This command displays the Add-in Manager, which lists the add-in projects
registered on the computer. You can use the Add-in Manager to enable or disable these add-ins.

Macros — The Macros submenu contains commands that help you create, edit, and execute
macros. See the section “Macros,” later in this chapter, for details.

ActiveX Control Test Container — This command displays the ActiveX Control Test Container,
which lets you test and debug ActiveX controls. You can use it to change the control’s proper-
ties, call its methods, and raise its events.

Create GUID — This command displays the Create GUID dialog shown in Figure 1-39 to let you
create a new globally unique identifier (GUID, pronounced to thyme with “squid”). Select the
GUID format that you need and click New GUID to generate a new GUID. Click Copy to copy
the result to the clipboard.

Dotfuscater Community Edition — This command launches the displays the Dotfuscater
Community Edition, a tool that you can use to make the intermediate language (IL) code
generated by Visual Basic more obscure and harder to reverse engineer.

Error Lookup — This command displays a small dialog where you can enter an error code and
see a description of the error.

ATL/MFC Trace Tool — If you are building Active Template Library (ATL) or Microsoft Foundation
Classes (MFC) projects, this command displays a tool that lets you view debug trace messages.

Spy++ — This command launches the Spy++ tool, which lets you view the messages sent to the
application.

External Tools — This command displays a dialog that lets you add and remove commands
from the Tools menu. For example, you could add a command to launch WordPad, MS Paint,
WinZip, and other handy utilities from the Tools menu.

Device Emulation Manager — This command displays the Device Emulation Manager, which lets
you connect, reset, shut down, and otherwise manipulate device emulators.
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Figure 1-39: The Create GUID dialog generates GUIDs.

Q  Import/Export Settings — This command displays a dialog that you can use to save, restore, or
reset your Visual Studio IDE settings.

’

Q  Customize — This command allows you to customize the Visual Studio IDE. See the “Customize”
section later in this chapter for details.

Q  Options — This command allows you to specify options for the Visual Studio IDE. See the
“Options” section later in this chapter for details.

Macros

The Macros submenu, shown in Figure 1-40, provides commands that help you create, edit, and execute
macros that automate repetitive Visual Studio programming chores. If you must perform a series of
actions many times, you can record a macro that performs them. Then you can call the macro repeatedly
to perform the actions rather than executing them manually.

After you have recorded a macro, you can edit the macro’s code and make changes. For example, if you
want to run the code a certain number of times, you can include it in a For loop. Often, a quick inspec-
tion of the code lets you figure out how to modify the code to perform actions similar to (but not exactly
the same as) the actions you originally recorded.

Most of the commands in the macros submenu are self-explanatory. Use the Record TemporaryMacro
command to record a macro for quick temporary use. When you select this command, a small window
pops up that contains buttons you can click to suspend, finish, or cancel recording. Visual Studio saves
the commands you execute in a macro named “TemporaryMacro.”

Select Run TemporaryMacro to run this macro. If you record a new TemporaryMacro, it overwrites the

existing one without warning you. Select the Save TemporaryMacro command to rename the macro so
you can record a new TemporaryMacro without destroying this one.
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Figure 1-40: The Macros submenu contains commands for recording and executing macros.

Select the Macro Explorer command to display the window shown in Figure 1-41. If you right-click on
a macro, the resulting pop-up menu lets you run, edit, rename, or delete the macro. Notice the Macro

Explorer’s predefined Samples section, which contains example macros that you can use or modify for
your own use.
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Figure 1-41: The Macro Explorer lets you edit,

run, and delete macros.
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Sometimes when you perform a series of programming tasks many times, there are better ways to
approach the problem than writing a macro. For example, you may be able to make your program repeat
the steps inside a loop. Or you may be able to extract the common code into a subroutine and then call it
repeatedly rather than repeating the code many times. In these cases, your application doesn’t need to
contain a long sequence of repetitive code that may be hard to debug and maintain.

Macros are generally most useful when you must write similar pieces of code that cannot be easily
extracted into a routine that can be shared by different parts of the application. For example, suppose
that you need to write event handlers for several dozen TextBox controls. You could record a macro
while you write one of them. Then you could edit the macro to make it generate the others in a loop
using different control names for each event handler. You could place the bulk of the event-handling
code in a separate subroutine that each event handler would call. That would avoid the need for exten-
sive duplicated code. (In fact, you could even use the AddHandler statement to make all the controls use
the same event handler. Then you wouldn’t even need to write all of the separate event handlers.)

Macros are also useful for manipulating the IDE and performing IDE-related tasks. For example, you can
write macros to show and hide your favorite toolbars, or to change whether the current file is opened
read-only.

Customize

The Tools menu’s Customize command displays the dialog shown in Figure 1-42. On the Toolbars tab,
check the boxes next to the toolbars that you want to be visible. Click New to create a new toolbar where
you can add your favorite tools. You can leave the toolbar floating or drag it to the edge of the IDE and
dock it. If you drag it to the top, it joins the other toolbars.

Customize [ 2] %]
Toolbars | Commands I

Toolbars:

| HTML Source Editing |
™ Image Editor

¥ Layout

¥ Menu Bar

[ Query Designer

[ Recorder Delete
™ Report Borders
| Report Formatting
[ Source Control

¥ Standard

[ Style Sheet

" Table Designer

[ Text Editor

[ view Designer

I XML Data

Rename...

1l

Reset...

El

[ use large icons
v Show SereenTips on toolbars

[~ Show shortcut keys in ScreenTips

Keyboard... | Close I

Figure 1-42: The Customize dialog’s Toolbar tab lets you
determine which toolbars are visible.
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Click the Commands tab to see a list of categories as shown in Figure 1-43. Select a category on the left.
Then click and drag a command from the list on the right. If you drop the command on a toolbar, the
command is added to the toolbar. Hover over a menu to open the menu so that you can drop the com-
mand in it.

Customize
Toolbars Commands |
Categories: Commands:
Add .HET Framework Launch Condition 2
Add Action
(Class Diagram
Community Add Assembly
[Crystal Reports Add Custom Action
Data -
Database Diagram Add Dialag
Debug Add File Launch Condition
Edit =
File Add File Search
Farmat Add File Type
Help
Image Add Internet Information Services Launel
Layout .
s G Add Launch Condition LI
Hew Menu Ll
Modify Selection -| Rearrange Commands...
To add a command, drag the command from the Commands list and drop
the command on the target toolbar or menu.
Keyhoard... | Close I

Figure 1-43: The Customize dialog’s Commands tab lets
you add commands to toolbars and menus.

To create a new menu, select the New Menu item in the list on the left. Then drag and drop the New
Menu entry from the right list onto the IDE’s menu area.

To make a command that executes a macro you have created, select the Macros category in the list on the
left. Find the macro you want to use in the list on the right, and drag it onto a toolbar or menu.

To remove a command from a toolbar or menu, right-click it and select Delete. Alternatively, you can
click and drag the command somewhere that it cannot be placed. For example, you can drop it on the
Customize dialog or most places in the IDE other than on a menu or toolbar (code editors, the Properties
window, the Toolbox). The mouse cursor changes to a box with an “X” beside it when the mouse is over
one of these areas.

Modifying the IDE’s standard menus and toolbars can cause confusion later. You may later discover
that you need a command that you have removed from a menu, and it may take you quite a while to find
it again. A better approach to modifying standard commands is to create a new custom toolbar or menu.
Add the commands you want to use to the new toolbar and then hide the standard toolbar that you are
replacing. Later you can restore the hidden standard toolbar if necessary.
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If you right-click a command in a menu or toolbar while the Customize dialog is open, Visual Studio dis-
plays the pop-up menu shown in Figure 1-44. Click the Name text box and enter a new name to change
the text displayed in the menu or toolbar.

Reset k.
a0

Delete

Hame: Myhacros.Modu

Copy Button Image

Paste Button Image

Reset Button Image

Edit Button Image...

Change Button Image p
Default Style

Text Only (Always)

Text Only (in Menus)

Image and Text

Begin a Group

Figure 1-44: Right-click menu and
toolbar commands to change
their appearances.

Use the Copy Button Image command to copy the button’s image to the clipboard. Use Paste Button
Image to paste a copied image onto a button. Usually you will use these two commands to copy the
image from an existing button to one you are adding. However, the Paste Button Image command will
paste any graphical image from the clipboard. For example, you can open a bitmap using Microsoft
Paint, press Ctrl-A to select the whole image, and press Ctrl-C to copy it to the clipboard. Then you can
use the Paste Button Image command to paste the image into a button. Note that the buttons are 16 by
16 pixels. If the image you copy is larger, Visual Studio shrinks it to fit.

Select the Reset Button Image command to restore the button to its default image. For a command tied to
a macro, this erases the image.

Select the Edit button image command to display the simple button editor shown in Figure 1-45. If you
click on a pixel that is not the selected foreground color (black in Figure 1-45), the editor changes the
pixel to the foreground color. If you hold the mouse down and drag it, the editor gives the pixels you
cross that color, too. If you click on a pixel that is already the foreground color, the editor erases the pixel
and any others that you drag over.

If you click the Change Button Image command, a menu containing several dozen standard images pops
out. Click one to assign that image to the button. A useful technique is to start with one of these images
and then edit it to customize it for your command.
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Figure 1-45: You can use Visual Studio’s simple
button editor to change a command’s button.

The pop-up menu’s Default Style command makes the command use a style that depends on whether it
is in a menu or toolbar. In a menu, the command displays a button and text. In a toolbar, the command
displays only a button. Ironically, a new button’s default style is not Default Style. When you create a
new toolbar or menu command, the button initially displays only text. You need to use the Default Style
command to make the button use this style.

Text Only (Always) makes the command display only text. Text Only (in Menus) makes a command in a
toolbar display a button and a command in a menu display text.

Image and Text makes the command display both an icon and text whether it is in a toolbar or a menu.
Finally, the Begin a Group command makes the IDE insert a group separator before the button.

The Customize dialog’s Rearrange Commands button displays a dialog that lets you rearrange the com-
mands in an existing menu or toolbar, and change the appearance of those commands. It’s usually easier

to just click and drag the commands on its menu or toolbar, however.

The Customize dialog’s Keyboard button displays the dialog shown in Figure 1-46. You can use this dis-
play to view and edit keyboard shortcuts.

Enter words in the “Show commands containing” text box to filter the commands. When you click on a
command, the dialog displays any keyboard shortcuts associated with it.

To make a new shortcut, click on the “Press shortcut key(s)” text box and press the keys that you want to

use as a shortcut. The “Shortcut currently used by” drop-down lists any commands that already use the
shortcut you entered. To make the assignment, click the Assign button.
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Figure 1-46: The Options dialog’s Keyboard section lets you view and modify
keyboard shortcuts.

Options

The Tools menu’s Options command displays the dialog shown in Figure 1-47. This dialog contains a
huge number of pages of options that configure the Visual Studio IDE. The Customize dialog’s Keyboard
button described in the previous section uses the same dialog with the Keyboard item selected in the list

on the left.
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Figure 1-47: The Options dialog lets you specify IDE options.
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The following list describes the Options dialog’s most important categories.

a

Environment — Contains general IDE settings such as whether the IDE uses an Multiple
Document Interface (MDI) or Single Document Interface (SDI) interface, the number of items
listed in the MRU lists, and how often the IDE saves AutoRecover information. The Fonts and
Colors subsection lets you determine the colors used by the editors for different types of text.
For example, comments are shown in green by default, but you can change this color.

Projects and Solutions — Contains the default settings for Option Explicit, Option Strict, and
Option Compare.

Source Control — Contains entries that deal with the source code control system (for example,
Source Safe).

Text Editor — Contains entries that specify the text editors’ features. For example, you can use
these pages to determine whether delimiters are highlighted, the editor provides drag-and-drop
editing, scroll bars are visible, long lines are automatically wrapped, line numbers are displayed,
and the editor provides smart indentation. The Basic\ VB Specific subsection lets you specify
options such as whether the editor uses outlining, whether it displays procedure separators, and
suggested corrections for errors.

Database Tools — Contains database parameters such as default lengths for fields of various types.

Debugging — Contains debugging settings such as whether the debugger displays messages
as modules are loaded and unloaded, whether it should make you confirm when deleting all
breakpoints, and whether it should allow Edit-and-Continue.

Device Tools — Contains options for development on devices such as Smartphones, Pocket PCs,
or Windows CE.

HTML Designer — Contains options for configuring HTML Designer. These options determine
such settings as whether the designer starts in source or design view, and whether it displays
Smart Tags for controls in design view.

Windows Form Designer — Contains settings that control the Form Designer. For example, this
section lets you determine whether the designer uses a snap-to grid or snap lines.

Window

The Window menu contains commands that control Visual Studio’s windows. Which commands are
enabled depends on the type of window that has the focus. Figure 1-48 shows this menu when the
Toolbox has the focus.
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Figure 1-48: The Window menu displays commands that control Visual Studio’s windows.

The following list briefly describes these commands.

New Window — Creates a new window displaying the contents of the current code window.

Split — Splits a code window into two panes that can display different parts of the code at the
same time. This command changes to Remove Split when you use it.

Dockable, Floating, Tabbed Document — Secondary windows such as the Toolbox, Solution
Explorer, and Properties windows can be displayed as dockable, as floating, or as tabbed docu-
ments. A dockable window can be attached to the edges of the IDE or docked with other sec-
ondary windows. A floating window stays in its own independent window even if you drag it
to a position where it would normally dock. A tabbed document window is displayed in the
main editing area in the center of the IDE with the forms, classes, and other project files.

Auto Hide — Puts a secondary window in Auto Hide mode. The window disappears, and its
title is displayed at the IDE’s nearest edge. When you click on the title or hover over it, the win-
dow reappears so that you can use it. If you click on another window, this window hides itself
again automatically.

Hide — Removes the window.

Auto Hide All — Makes all secondary windows enter Auto Hide mode.
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Q  New Horizontal Tab Group — Splits the main document window horizontally so that you can
view two different documents at the same time.

Q  New Vertical Tab Group — Splits the main document window vertically so that you can view
two different documents at the same time.

Q  Close All Documents — Closes all documents.

Q  Reset Window Layout — Resets the window layout to a default configuration.

Q  Forml.vb — The bottom part of the Window menu lists the open documents. In Figure 1-48, it
lists Form1.vb in the code editor and Form1.vb [Design] in the Form Designer (Design mode).
The code editor entry is checked because it is the currently active document.

Q  Windows — If you have too many open documents to display in the Window menu, select this
command to see a list of windows in a dialog. This dialog lets you switch to another document,
close one or more documents, or save documents. By using Ctrl-Click and Shift-Click you can
select more than one document and quickly close them.

Community

The Community menu shown in Figure 1-49 contains commands that can help you connect with the
Visual Basic programming community. These commands lead to various Microsoft Web pages where
you can ask questions, send feedback, search for examples, find snippets, and so forth.
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| |2 & 2| T ok a5 3] B g [eee 30 0 g | & Xt 24 aiWA SendFeedback
Toolbox - I x ,/Fm| ¥] Check Question Status o -Windo... = L X
= = Developer Center =&
al A A = S B® Form1 [_ |0 2
= Codezone Community pplication1
o2 g = - =
= CommumtySe:frch » agrami.cd
(T[T [ - [Z] Form1ab
LR
Fom o O
£ 2 = o4
L | s ;ﬂDa\tn Sources JﬂSolmionExplorer
T OE N = Properties -~ I x
e 3 Error List > I %
OIJErrors JSIIWarnings _DnMessages " |
=l 7 =
| | Fie | Line | coumn | Project
(DataBindings) -
AcceptsReturn False
AcceptsTab False
AccessibleDesy
AccessibleNam =
{DataBindings)
1| | » | | The data bindings for the control.

22 WindowsApplication1 - Microsoft Visual Studio

= I_‘,‘é Error List |gj Task List | ] Command ... | 5] Output |(=]immediate ...

Figure 1-49: The Community menu contains commands that give access to Microsoft’s Visual Basic
developer community.
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For other Visual Basic community resources, see the “community support” topic in the MSDN help or
visit the Web page http:/ /msdn.microsoft.com/library/en-us/vsintro7 /html/vxoriAdditionalResources
ForVisualStudioDevelopers.asp. Also see the Visual Studio 2005 Home Page at http:/ /msdn.microsoft
.com/vs2005/default.aspx. Microsoft may move these pages but you should be able to find them if

you search Microsoft’s Web site for “Additional Resources for Visual Studio Developers” and “Visual
Studio 2005.”

Help
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The Help menu shown in Figure 1-50 displays the usual assortment of help commands. You should be
familiar with most of these from previous experience.

@0 WindowsApplication1 - Microsoft Visual Studio
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Figure 1-50: The Help menu contains commands that give you help.

One new item in the Help menu is the How Do I command. This command opens the help system and
displays a page full of links to common programming topics. These topics lead to a hierarchical series
of categorized tutorials on various programming topics. For example, the Visual Basic > Language >
Basics > Data Types > Data Type Summary topic describes the Visual Basic data types, their storage
requirements, and their ranges of allowed values.
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Toolbars

Visual Studio’s toolbars are easy to rearrange. Grab the four gray dots on a toolbar’s left or upper edge
and drag the toolbar to its new position. If you drag a toolbar to one of Visual Studio’s edges, it will dock
there either horizontally (on the IDE’s top or bottom edge) or vertically (on the IDE’s left or right edge). If
you drop a toolbar away from the IDE’s edges, it becomes a floating window not docked to the IDE.

You can use the menu commands described earlier in this chapter to determine which toolbars are visi-
ble, to determine what they contain, and to make custom toolbars of your own.

Many menu commands are also available in standard toolbars. For example, the Debug toolbar contains
many of the same commands that are in the Debug menu. If you use a set of menu commands frequently,
you may want to display the corresponding toolbar to make using the commands easier.

Secondary Windows

You can rearrange secondary windows such as the Toolbox and Solution Explorer almost as easily as
you can rearrange toolbars. Click and drag the window’s title area to move it. As the window moves, the
IDE displays little blue icons to help you dock the window, as shown in Figure 1-51. This figure probably
looks somewhat confusing, but it’s fairly easy to use.

The IDE displays four docking icons near the edges of the IDE. You can see these icons near the edges of
Figure 1-51. If you drop the window on one of these icons, the window docks to the corresponding edge
of the IDE.

When you drag the window over another window, the IDE displays docking icons for the other window.
In Figure 1-51, these are the five icons near the mouse in the middle of the screen. The four icons on the
sides dock the window to the corresponding edge of the other window.

The center icon places the dropped window in a tab within the other window. If you look closely at
Figure 1-51, you can see a little image of a document with two tabs on the bottom in this icon.

When you drag the mouse over one of the docking icons, the IDE displays a dark gray rectangle to give
you an idea of where the window will land if you drop it. In Figure 1-51, the mouse is over the main
document window’s right docking icon, so the grayed rectangle shows the dropped window taking up
the right half of the main document window.

If you drop a window somewhere other than on a docking icon, the window becomes free-floating.

Once you drop a window on the main document area, it becomes a tabbed document, and you cannot
later pull it out. To free the window, select it and use the Window menu’s Dockable or Floating command.
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2 WindowsApplication1 - Microsoft Visual Studio
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Figure 1-51: Use the IDE’s docking icons to help you dock windows.

®

Sometimes the IDE is so cluttered with windows that it’s hard to figure out exactly where the window
will be dropped. It’s usually fairly easy to just move the mouse around a bit and watch the grayed rect-

angle to see what’s happening.

The windows in the Microsoft Document Explorer used by the MSDN Library and other external help
files provides the same arranging and docking tools for managing its subwindows such as Index,

Contents, Help Favorites, Index Results, and Search Results.

Toolbox

The Toolbox window displays a series of sections containing tools for the currently active document.
These tools are grouped into sections called tabs, although they don’t look much like the tabs on most doc-
uments. In Figure 1-52, the Toolbox displays tools for the form designer grouped into the All Windows
Forms, Common Controls, Containers, Menus & Toolbars, Data, Components, Printing, Dialogs, and
General tabs. In this figure, the Toolbox was enlarged greatly to show most of its contents. Most develop-
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{Toolbox

Figure 1-52: The Toolbox window can display tools by name or icon.

You can customize the Toolbox by right-clicking on it and selecting one of the commands in the context
menu. The following list briefly describes these commands.

a
a

List View — Toggles the current tab to display tools either as a list of names or a series of icons.

Show All — Shows or hides less commonly used tool tabs such as XML Schema, Dialog Editor,
DataSet, Login, WebParts, Report Items, Device Controls, and many others.

Choose Items — displays the dialog shown in Figure 1-53. Use the .NET Framework Components
tab to select .NET tools, and use the COM Components tab to select COM tools. Click the Browse
button to locate tools that are not in either list.

Sort Items Alphabetically — Sorts the items within a Toolbox tab alphabetically.

Reset Toolbox — Restores the Toolbox to a default configuration. This removes any items you
may have added by using the Choose Items command.

Add Tub — Creates a new tab where you can place your favorite tools. You can drag tools from
one tab to another. Hold down the Ctrl key while dragging to add a copy of the tool to the new
tab without removing it from the old tab.
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Q  Delete Tub — Deletes a tab.

(]

Rename Tab — Lets you rename a tab.

Q  Move Up, Move Down — Moves a tab up or down in the Toolbox. You can also click and drag
the tabs to new positions.
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The Visual Basic Code Editor

Visual Studio includes editors for many different kinds of documents, including several different kinds
of code. For example, it has Hypertext Markup Language (HTML), Extensible Markup Language (XML),
and Visual Basic editors. These editors share some common features, such as displaying comments and
keywords in different colors.

Figure 1-53: Use the Choose Toolbox Items dialog to select the tools in the Toolbox.

As a Visual Basic developer, you will use the Visual Basic code editor frequently, so you should spend a
few minutes learning about its specialized features.

Figure 1-54 shows the code editor displaying some Visual Basic code at run time. To make referring to
the code lines easier, this figure displays line numbers. To display line numbers, invoke the Tools menu’s
Options command, navigate to the Text Editor\Basic\General page, and check the Line Numbers box.
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Figure 1-54: The Visual Basic code editor provides many features, including line humbers and icons that
indicate breakpoints and bookmarks.

Margin Icons

The gray margin to the left of the line numbers contains icons giving information about the correspond-
ing lines of code. The following table describes the icons on lines 4 through 11.

Line Icon Meaning

4 Yellow arrow Indicates that execution is paused at this line

5 Red circle Indicates a breakpoint

6 Hollow red circle Indicates a disabled breakpoint

7 Red circle with plus sign Indicates a breakpoint with a condition or hit count test

10 Red diamond Indicates a breakpoint that executes an action when reached
11 Blue and white rectangle Indicates a bookmark
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These icons can combine to indicate more than one condition. For example, line 12 shows a blue and
white rectangle to indicate a bookmark, a hollow red diamond to indicate a disabled breakpoint that
performs an action, and a plus sign to indicate that the breakpoint has a condition or hit count test.

Note that the editor marks some of these lines in other ways than just an icon. It highlights the currently
executing line with a yellow background. It marks lines that hold enabled breakpoints with white text
on a red background.

To add or remove a simple breakpoint, click in the gray margin.

To make a more complex breakpoint, click in the margin to create a simple breakpoint. Then right-click
the breakpoint icon and select one of the context menu’s commands. The following list describes these
commands.

Q  Delete Breakpoint — Removes the breakpoint.

Q  Disable Breakpoint — Disables the breakpoint. When the breakpoint is disabled, this command
changes to Enable Breakpoint.

Q  Location — Lets you change the breakpoint’s line number. Usually it is easier to click in the
margin to remove the old breakpoint and then create a new one.

Q  Condition — Lets you place a condition on the breakpoint. For example, you can make the
breakpoint stop execution only when the variable num_employees has a value greater than 100.

Q  Hit Count — Lets you set a hit count condition on the breakpoint. For example, you can make
the breakpoint stop execution when it has been reached a certain number of times.

Q  When Hit — Lets you specify the action that the breakpoint performs when it triggers. For
example, it might display a message in the Output window or run a macro.

To add or remove a bookmark, place the cursor on a line and then click the Toggle Bookmark tool. You
can find this tool, which looks like the blue and white bookmark icon, in the Text Editor toolbar (under
the mouse in Figure 1-54) and at the top of the Bookmarks window. Other bookmark tools let you move
to the next or previous bookmark, the next or previous bookmark in the current folder, or the next or
previous bookmark in the current document. The final bookmark command clears all bookmarks.

Outlining
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By default, the code editor displays an outline view of code. If you look at the first line in Figure 1-54,
you'll see a box with a minus sign in it just to the right of the line number. That box represents the out-
lining for the Form1 class. If you click this box, the editor collapses the class’s definition and displays it
as a box containing a plus sign. If you then click the new box, the editor expands the class’s definition
again.

The gray line leading down from the box leads to other code items that are outlined, and that you can
expand or collapse to give you the least cluttered view of the code you want to examine. Near the bot-
tom of Figure 1-54, you can see that the RandomizeArray subroutine has been collapsed. The ellipsis
and rectangle around the routine name provided an extra indication that this code is hidden.
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The editor automatically creates outlining entries for namespaces, classes and their methods, and mod-
ules and their methods. You can also use the Region statement to group a section of code for outlining.
For example, you can place several related subroutines in a region so you can collapse and expand the
routines as a group.

Figure 1-55 shows more examples of outlining. Line 37 begins a region named Randomization Functions
that contains three collapsed subroutines. Notice that the corresponding End Region statement includes a
comment giving the region’s name. This is not required but it makes the code easier to understand when
you are looking at the end of a region.

Line 90 contains a collapsed region named Utility Functions.

Line 96 starts a module named HelperRoutines that contains one collapsed subroutine.

Finally, Line 109 holds the collapsed ImageResources namespace.

Notice that the line numbers skip values for any collapsed lines. For example, the

RandomizelIntegerArray subroutine is collapsed on line 39. This subroutine contains 15 lines
(including the sub statement), so the next visible line is labeled 54.
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Figure 1-55: The code editor outlines namespaces, classes and their methods, modules and their
methods, and regions.
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Also notice that comments before a subroutine are not collapsed with the subroutine. You can make
reading collapsed code easier by placing a short descriptive comment before each routine.

Tooltips

56

If you hover the mouse over a variable at design time, the editor displays a tooltip describing the vari-

able. For example, if you hover over an integer variable named num_actions, the tooltip would display
“Dim num_actions As Integer.”

If you hover over a subroutine or function call, the tooltip displays information about that method. For
example, if you hover over the RandomizeArray subroutine (which takes an array of integers as a
parameter), the tooltip says, “Private Sub RandomizeArray(arr() As Integer).”

At run time, if you hover over a variable, the tooltip displays the variable’s value. If the variable is com-
plex (such as an array or structure), the tooltip displays the variable’s name and a plus sign. If you click
or hover over the plus sign, the tooltip expands to show the variable’s members.

In Figure 1-56, the mouse hovered over variable arr. The editor displayed a plus sign and the text arr
{Length = 100}. When the mouse hovered over the plus sign, the editor displayed the values shown in

the figure. Moving the mouse over the up and down arrows at the top and bottom of the list makes the
values scroll.
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Figure 1-56: You can hover the mouse over a variable at run time to see its value.



IDE

If a variable has properties that are references to other objects, you can hover over their plus signs to

expand those objects. You can continue following the plus signs to drill into the variable’s object hierar-

chy as deeply as you like.

IntelliSense

If you start typing a line of code, the editor tries to anticipate what you will type. For example, if you
type “Me.” then the editor knows that you are about to use one of the current object’s properties or

methods.

IntelliSense displays a list of the properties and methods that you might be trying to select. As you type
more of the property or method, IntelliSense scrolls to show the choices that match what you have typed.

In Figure 1-57, the code includes the text me. set, so IntelliSense is displaying the current object’s meth-

ods that begin with the string set.

While the IntelliSense window is visible, you can use the up and down arrows to scroll through the list.
While IntelliSense is displaying the item that you want to use, you can press the Tab key to accept that
item. Press the Escape key to close the IntelliSense window and type the rest manually.
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Figure 1-57: IntelliSense displays a list of properties and methods that you might be trying to type.
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After you finish typing a method and its opening parenthesis, IntelliSense displays information about
the method’s parameters. Figure 1-58 shows parameter information for a form object’s SetBounds
method. This method takes four parameters: %, y, width, and height.

IntelliSense shows a brief description of the current parameter x. As you enter parameter values,
IntelliSense moves on to describe the other parameters.

IntelliSense also indicates whether there are overloaded versions of the method. In Figure 1-58, IntelliSense
is describing the first version of two available versions. You can use the up and down arrows on the left to
move through the list of overloaded versions.

Code Coloring and Highlighting
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The code editor displays different types of code items in different colors. You can change the colors used
for different items by selecting the Tools menu’s Options command, and opening the Environment\Fonts
and Colors option page. To avoid confusion, however, you should probably leave the colors alone unless
you have a good reason to change them.
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Figure 1-58: IntelliSense displays information about a method’s parameters.
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The following table describes some of the default colors that the code editor uses to highlight different
code elements.

Item

Comment
Compiler error

Other error

Highlighting

Green text
Underlined with a wavy blue underline

Underlined with a wavy green underline

Keyword Blue text

Preprocessor keyword Blue text

Read-only region Light gray background

Stale code Purple text

User types Navy text

User types, delegates Navy text

User types, enums Teal text

User types, interfaces Navy text

User types, value types Teal text

Warning Underlined with a wavy purple underline

A few other items that may be worth changing have white backgrounds and black text by default. These
include identifiers (variable names, types, object properties and methods, namespace names, and so
forth), numbers, and strings.

When the code editor finds an error in your code, it highlights the error with a wavy underline. If you
hover over the underline, the editor displays a tooltip describing the error. If Visual Studio can guess
what you are trying to do, it adds a small flat rectangle to the end of the wavy error line to indicate that
it may have useful suggestions.

The assignment statement i = "12" shown in Figure 1-59 has an error because it tried to assign a string
value to an integer variable and that violates the Option Strict On setting. The editor displays the wavy
error underline and a suggestion indicator because it knows a way to fix this error.

If you hover over the suggestion indicator, the editor displays a tooltip describing the problem and an
error icon. If you click the icon, Visual Studio displays a dialog describing the error and listing the
actions that you may want to take. Figure 1-60 shows the suggestion dialog for the error in Figure 1-59. If
you click the text over the revised sample code, or if you double-click the sample code, the editor makes
the change.
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Figure 1-59: If the code editor can figure out what'’s wrong, it displays a suggestion indicator.

Code Snippets
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A code snippet is a piece of code that you might find useful in many applications. It is stored in a snip-
pet library so that you can quickly insert it into a new application.

Visual Studio comes with hundreds of snippets for performing standard tasks. Before you start working
on a complicated piece of code, you should take a look at the snippets that are already available to you.
In fact, it would be worth your time to use the Snippet Manager available from the Tools menu to take a
good look at the available snippets right now before you start a new project. There’s little point in you

reinventing methods for calculating statistical values if someone has already done it and given you
the code.

Snippets are stored in simple text files with XML tags, so it is easy to share snippets with other develop-
ers. Go to this book’s Web page, www . vb-helper.com/vbprogref .htm, to contribute snippets and to
download snippets contributed by others.
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Figure 1-60: The error suggestion dialog proposes likely solutions to an error.

The following sections explain how to use snippets in your applications and how to create new snippets.

Using Snippets

To insert a snippet, right-click where you want to insert the code and select Insert Snippet to make the
editor display a list of snippet categories. Double-click a category to find the kinds of snippets that you
want. If you select a snippet, a tooltip pops up to describe it. Figure 1-61 shows the editor preparing to
insert the snippet named “Create a public property” from the “VbProgRef CodeSnippets” category.
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Figure 1-61: When you select a code snippet, a pop-up describes it.

Double-click on the snippet to insert it into your code. The snippet may include values that you should
replace in your code. These replacement values are highlighted with a light green background, and the
first value is initially selected. If you hover the mouse over one of these values, a tooltip appears to
describe the value. You can use the Tab key to jump between replacement values.

Figure 1-62 shows the inserted code for this example. The text An Integer Property is highlighted and
selected. Other selected text includes Integer, 0, and MyProperty. The mouse is hovering over the
value An Integer Property, so the tooltip explains that value’s purpose.
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Figure 1-62: Values that you should replace in a snippet are highlighted.

Creating Snippets

To create a new snippet, you need to build an XML file containing the property tags to define the snippet
and any replacements that the user should make. The following code shows the “Create a public prop-
erty” snippet used in the previous section. The outer CodeSnippets and CodeSnippet tags are stan-
dard and you should not change them.

Use the Title tag in the Header section to describe the snippet.

Inside the Snippet tag, build a Declarations section describing any literal text that the user should
replace. This example defines DataType, Description, DefaultValue, and PropertyName symbols.
Each literal definition includes an ID, and can include a ToolTip and Description.

After the declarations, the Code tag contains the snippets source code. The syntax <! [CDATA[...]]>

tells XML processors to include any characters including carriage returns between the <! [CDATA[ and
the 11> in the enclosing tag.
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<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>Create a public property</Title>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>DataType</ID>
<ToolTip>The property's data type.</ToolTip>
<Default>Integer</Default>
</Literal>
<Literal>
<ID>Description</ID>
<ToolTip>The property's description.</ToolTip>
<Default>An Integer property.</Default>
</Literal>
<Literal>
<ID>DefaultValue</ID>
<ToolTip>The property's default value.</ToolTip>
<Default>0</Default>
</Literal>
<Literal>
<ID>PropertyName</ID>
<ToolTip>The property's name.</ToolTip>
<Default>MyProperty</Default>
</Literal>
</Declarations>
<Code Language="VB">
<! [CDATA[
' $Description$
Private m_S$PropertyName$ As $DataType$ = SDefaultValue$
Public Property S$PropertyNames$ () As $DataType$
Get
Return m_SPropertyName$
End Get
Set (ByVal value As S$DataType$)
m_SPropertyName$ = value
End Set
End Property

</Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>

Save the snippet’s XML definition in a snippet directory. To add the directory to the list of usable
snippet locations, select the Tool menu’s Code Snippets Manager command to display the tool shown
in Figure 1-63. Click the Add button, browse to the new snippet directory, and click OK. Now the direc-
tory and the snippets that it contains will be available in the Insert Snippet pop-ups.
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Figure 1-63: The Code Snippets Manager lets you add and remove
snippet directories.

The Code Editor at Run Time

The code editor behaves slightly differently at run time and design time. Many of its design time fea-
tures still work. Breakpoints, bookmarks, IntelliSense, and snippets still work.

At run time, the editor adds new tools for controlling the program’s execution. Right-click on a value
and select Add Watch or QuickWatch to examine and monitor the value. Use the Stop Into, Step Over,
and Step Out commands on the Debug menu or toolbar to make the program walk through the code.

Right-click on a statement and select Show Next Statement to move the cursor to the next statement that
the program will execute. Select Run To Cursor to make the program continue running until it reaches
the cursor’s current line.

Right-click and select Set Next Statement to make the program jump to a new location. You can also
drag the yellow arrow indicating the next statement to a new location in the left margin. There are some
restrictions on where you can move the execution position. For example, you cannot jump out of one
routine and into another.

You can discover other run-time features by exploring the editor at run time. Right-click on different
parts of the editor to see which commands are available in that mode.

65



Chapter 1

Summary

66

The Visual Studio integrated development environment provides many tools for writing and debugging
applications. It provides code snippets that make saving and reusing code easy. It lets you add, remove,
and disable complex breakpoints that check conditions and hit counts, and that can perform customized
actions. You can use regions and bookmarks to organize and find pieces of code, and you can step
through the code line by line at execution time.

The IDE is extremely flexible. You can show, hide, and rearrange windows; add and remove items from

menus and toolbars; and write macros to automate simple chores. Context menus attached to all sorts of
objects provide help, tools, and other features that make sense for their particular objects and under dif-
ferent situations.

This chapter describes some of the most useful parts of the IDE, but listing every last nook and cranny
would be tedious and not terribly useful. Rather than reading about the IDE further, you would be better
off experimenting with it. Spend a few hours really examining all of the menus. Create a snippet with
some replacement values and then insert it into your code. Step through a small program and try the
Immediate and Command windows.

While you do all this, and while you're developing real applications, right-click on things to see what
sort of context menus they provide. The IDE is packed with so many tools that it is sometimes hard to
find the one you want. Because context menus are tied closely to the objects that you click to display
them, they often provide more appropriate and focused commands than the toolbars or menus.

After you have used the IDE for a while and are comfortable with it, customize it to match your prefer-
ences. Build custom toolbars and menus to make using your favorite tools easier. When you have the
tools that you use most at your fingertips, you will see just how productive Visual Studio can be.

Once you have become familiar with the IDE, you can start building applications. One way to begin is to
design the application’s user interface: the forms, labels, text boxes, and other controls that the user sees
and manipulates to control the application. Chapter 2, “Controls in General,” describes controls in gen-
eral terms. It explains what controls are, how you can add them to a form, and how you can control and
interact with them at design time and run time.



Controls in General

A control is a programming object that has a graphical component. A control sits on a form and
interacts with the user, providing information and possibly allowing the user to manipulate it.
Text boxes, labels, buttons, scroll bars, drop-down lists, menu items, toolstrips, and just about
everything else that you can see and interact with in a Windows application is a control.

A component is similar to a control, except it has no visible component at run time. When you add a
component to a form at design time, it appears in the component tray below the bottom of the form.
You can select the component and use the Properties window to view and change its properties. At
run time, the component is invisible to the user, although it may display a visible object such as a
menu, dialog, or status icon.

Figure 2-1 shows Visual Basic’s Toolbox displaying a standard assortment of 67 controls and com-
ponents. The arrow tool in the upper-left corner represents the selection tool and is not a control or
component.

This chapter explains controls and components in general terms. It describes different kinds of
controls and components. It explains how your program can use them at design time and run time
to give the user information and to allow the user to control your application.

It explains in general terms how a control’s properties, methods, and events work, and it lists
some of the most useful properties, methods, and events provided by the Control class. Other con-
trols that are derived from this class inherit the use of those properties, methods, and events unless
they are explicitly overridden.

Appendix G, “Standard Controls and Components,” describes specific controls in greater detail.
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Controls and Components
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Most controls are graphic by nature. Buttons, text boxes, and labels provide graphical input and feed-
back for the user. They display data and let the user trigger program actions. Some controls (such as grid
controls, tree view controls, and calendar controls) are quite powerful and provide a rich variety of tools
for interacting with the user.

On the other hand, components are represented by graphical icons at design time, and they are hidden
at run time. They may display some other object (such as a dialog, menu, or graphical indicator), but the
component itself is hidden from the user.

Generally, your code could use a component’s features at run time without requiring you to place an
object on a form. For example, the program could easily call a method that displays a dialog. However,
putting important functions in components rather than making them subroutine calls provides several
benefits.

First, because you can add a component to a form graphically at design time, you don’t need to write
code to instantiate it and set its properties at run time. That would not be particularly difficult, but it
would just be a little less convenient.
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Adding a component to a form at design time also lets you manipulate it at design time instead of in
code. You can use the Properties window to view and modify a component’s properties at design time.
You can also use the code editor to make event handlers for the component (event-handler creation is
described in greater detail later in this chapter).

There are still times when it’s useful to create controls at run time. For instance, if you don’t know how
many text boxes you will need until run time, you cannot create them all at design time. Fortunately,
you get the best of both worlds: Visual Basic lets you create controls at either design time or run time.

Some components also provide information needed by graphical controls. For example, a program can
use connection, data adapter, and data set components to define data that should be selected from a
database. Then a grid control could then display the data to the user. Because the connection, data
adapter, and data set objects are components, you can define all this at design time without writing code.

Figure 2-2 shows a form at design time that contains several components. The components appear in the
Component Tray at the bottom of the form, not on the form’s graphical surface.
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Figure 2-2: Some components provide data for graphical controls.
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This example contains four components. Timer1 fires an event periodically so the program can take
some action at specified time intervals. ErrorProvider1 displays an error icon and error messages for
certain controls on the form such as TextBoxes. BackgroundWorkerl performs tasks asynchronously
while the main program works independently. ImageList1 contains a series of images. Usually an
ImageList is associated with a control such as a Button, ListView, or TreeView, and provides images
for the control.

Aside from the lack of a graphical component on the form, working with components is about the same
as working with controls. You use the Properties window to set components’ properties, the code editor
to define event handlers, and code to call their methods. The rest of this chapter focuses on controls, but
the same concepts apply just as well to components.

reating Controls

Usually you add controls to a form graphically at design time. In some cases, however, you may want to
add new controls to a form at run time. This gives you a bit more flexibility so that you can change the
program’s appearance at run time in response to the program’s needs or the user’s commands.

For example, suppose that an application might need between 1 and 100 text boxes. Most of the time it
needs only a few, but depending on the user’s input, it might need a lot. You could give the form 100
text boxes and then hide the ones it didn’t need, but that would be a waste of memory most of the time.
By creating only the number of text boxes actually needed, you can conserve memory in the most com-
mon cases.

The following sections explain how to create controls both at design time and at run time.

Creating Controls at Design Time
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To create a control at design time, double-click on a form in Solution Explorer to open it in the form edi-
tor. Decide which control you want to use from the Toolbox. If the Toolbox tab you are using is in List
View mode, it displays the controls” names. If the tab displays only control icons, you can hover the
mouse over a tool to see a tooltip that gives the control’s name and a brief description. Figure 2-3 shows
a tooltip describing the HelpProvider component.

After you have chosen a control, there are several ways you can add it to the form. First, you can double-
click on the tool to place an instance of the control on the form at a default size in a default location.
After adding the control to the form, the IDE deselects the tool and selects the pointer tool (the upper
leftmost tool in the Toolbox’s current tab).

A second way you can add a control to a form is to select it in the Toolbox, and then click and drag to
place it on the form. If you click on the form without dragging, the IDE adds a new control at that posi-
tion with a default size. After you add the control, the IDE deselects the tool and selects the pointer tool.

Third, if you click and drag a tool from the Toolbox onto the form, Visual Basic makes a new control
with a default size at the position where you dropped the tool.
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Figure 2-3. Hover the mouse over a toolbox icon to see the tool’s description.

Fourth, if you plan to add many copies of the same type of control to the form, hold down the Ctrl key
and click on the tool. Now the tool remains selected even after you add a control to the form. If you click
and drag on the form, the IDE creates a new control at that position and keeps the tool selected so that
you can immediately create another control. If you click on the form without dragging the mouse, the
IDE adds a new control at that position with a default size. When you are finished adding instances of
that control type, click the pointer tool to stop adding new controls.

After you have added controls to a form, there are a couple ways you can make copies of those controls.
First, you can select some controls, press Ctrl-C to copy them to the clipboard, and press Ctrl-V to paste
them back onto the form at a default location.

Similarly, you can copy and paste controls to other forms. For example, an application might need sev-
eral dialog boxes that all display similar text in labels, pictures in picture boxes, and OK and Cancel but-

tons. After you create one dialog, you can copy and paste its controls onto other dialogs to build them
more quickly.

The copied controls have the same property values as the originals (except for their names, which must
always be unique). If you want to make a series of controls with the same properties, you can make one,
set its properties, and then use copy and paste to make the others.
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Another way to copy existing controls is to select them, click and drag, and hold down the Ctrl key
when you drop them. This makes copies of the controls at the position where you drop them. This tech-
nique is particularly useful for making a large array of controls aligned in rows or columns. If you use
Ctrl-C and Ctrl-V to copy and paste the controls, they appear in a default location and you must reposi-
tion them in a separate step. If you drag and drop while pressing the Ctrl key, you can position the
copies as you make them.

Selecting Controls
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Telling you to select controls to copy them begs the question, how do you select the controls? Click on a
control on the form to select it. Hold down the Shift or Ctrl key while clicking to add or remove a control
from the selection without removing any other controls from the current selection.

Click and drag over part of the form to select all of the controls that intersect the rectangle you define
with the mouse. Hold down the Ctrl key while you click and drag to select controls without removing
any currently selected controls from the selection.

Some controls can contain other controls. When you click and drag to select the controls in an area,
Visual Basic selects only controls contained in the control on which you initially click. For example,
Figure 2-4 shows a form that contains eight buttons. The four buttons on the left are contained in the
form itself. The four buttons on the right are contained in a Panel control.
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Figure 2-4: When you click and drag on a form, Visual Basic selects only controls with the same
container.



Controls in General

If you click on an open piece of form and drag to select an area that covers every control on the form,
Visual Basic selects the four buttons on the left and the Panel control because they are all contained in the
form itself. It does not select the buttons on the right because they are contained in the Panel control.

If you click on the interior of the Panel control and then drag to surround all of the controls, Visual
Basic selects only the four buttons on the right because they are contained in the Panel control.

If you want to select controls from more than one container, you must hold down the Ctrl key and click
(or click and drag) to select the controls in several steps. In this case, you might click and drag on the
form to select the buttons on the left and the panel control. Next you would press Ctrl, click in the
panel control, and drag to select the remaining buttons. Unfortunately, clicking on the panel control
deselects it so you need to press Ctrl and click on the Panel again to reselect it. (If you want to select all
of the controls on the form, you can also click on the form and press Ctrl-A.)

After you have selected the controls you want to manipulate, you can delete them, copy them, drag
them to a new location, modify their common properties using the Properties window, and so forth.

Container Controls

As the previous section mentions, some controls can contain other controls. For example, the GroupBox
and Panel controls can hold other controls.

There are several ways you can place a control in a container. If you select the container and then double-
click a control’s tool in the Toolbox, Visual Basic places the new control inside the container.

If you select a tool and click and drag inside a container, Visual Basic also places the new control inside
the container, whether it is selected or not.

You can also click and drag a Toolbox tool onto the container, or click and drag controls from one part of
the form onto the container. If you hold down the Ctrl key when you drop the controls, Visual Basic
makes new copies of the controls.

Two common mistakes programmers make with containers is placing a control above a container when
they want it inside the container, and vice versa. For example, you can place different controls inside dif-
ferent Panel controls and then hide or display the Panels to show different controls at different times. If
a control lies above a Panel but is not inside it, the control remains visible even if the Panel is not.

To tell if a control is inside a container, move the container slightly. If the control also moves, it is inside
the container. If the control doesn’t move, it is above the container but not inside it.

Creating Controls at Run Time

Normally, you create controls interactively at design time. Sometimes, however, it’s more convenient to
create new controls at run time. For example, you may want to provide different interfaces for different
users. Users with different skill levels or authorizations may need to use different controls to do their
jobs. Or you may not know how many pieces of data you will need to display until run time. Sometimes
you can display unknown amounts of data using a list, grid, or other control that can hold a variable
number of items, but other times you might like to display the data in a series of labels or text boxes. In
cases such as these, you need to create new controls at run time.
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The following code shows how a program might create a new Label control. First it declares a variable
of type Label and initializes it with the New keyword. It uses the label’s SetBounds method to position
the label and sets its Text property to “Hello World!” The code then adds the label to the current form’s
Controls collection.

Dim 1bl As New Label
1bl.SetBounds (10, 50, 100, 25)
1bl.Text = "Hello World!"
Me.Controls.Add (1bl)

Usually, a label just displays a message so you don’t need to catch its events. Other controls such as but-
tons and scroll bars, however, are not very useful if the program cannot respond to their events.

There are two approaches you can take to catching a new control’s events. First, you can declare the con-
trol’s variable with the withEvents keyword. Then you can open the form in the code editor, select the
variable’s name from the left drop-down list, and select the event from the right drop-down list to give
the control an event handler.

The following code demonstrates this approach. It declares variable btnHi at the module level using the
withEvents keyword. When you click the btnMakeHiButton button, its event handler initializes the
variable. It sets the control’s position and text, and adds it to the form’s Controls collection. When the
user clicks this button, the btnHi_Click event handler executes and displays a message.

' Declare the btnHi button WithEvents.
Private WithEvents btnHi As Button

' Make the new btnHi button.
Private Sub btnMakeHiButton_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnMakeHiButton.Click
btnHi = New Button
btnHi.SetBounds (96, 50, 75, 23)
btnHi.Text = "Say Hi"
Me.Controls.Add (btnHi)
End Sub

' The user clicked the btnHi button.

Private Sub btnHi_Click(ByVal sender As Object, _

ByVal e As System.EventArgs) Handles btnHi.Click
MessageBox.Show ("Hi")

End Sub

This first approach works if you know how many controls you need. Then you can define variables for
them all using the withEvents keyword. If you don’t know how many controls you need to create,
however, this isn’t practical. For example, suppose that you want to create a button for each file in a
directory. When the user clicks on a button, the file should open. If you don’t know how many files the
directory might hold, you don’t know how many variables you might need.

One solution to this dilemma is to use the AddHandler statement to add event handlers to the new con-
trols. The following code demonstrates this approach. When you click the btnMakeHelloButton but-
ton, its C1ick event handler creates a new Button object, storing it in a locally declared variable. It sets
the button’s position and text and adds it to the form’s Controls collection as before. Next, the program
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uses the AddHandler statement to make subroutine Hello_Click an event handler for the button’s
Click event. When the user clicks the new button, subroutine Hello_C1lick displays a message.

' Make a new Hello button.
Private Sub btnMakeHelloButton Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles btnMakeHelloButton.Click

' Make the button.

Dim btnHello As New Button

btnHello.SetBounds (184, 50, 75, 23)

btnHello.Text = "Say Hello"

Me.Controls.Add (btnHello)

' Add a Click event handler to the button.
AddHandler btnHello.Click, AddressOf Hello_Click
End Sub

' The user clicked the Hello button.
Private Sub Hello_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs)
MessageBox.Show ("Hello")
End Sub

You can use the same routine as an event handler for more than one button. In that case, the code can
convert the sender parameter into a But ton object and use the button’s Name, Text, and other properties
to determine which button was pressed.

To remove a control from the form, simply remove it from the form’s Controls collection. To free the
resources associated with the control, set any variables that refer to it to Nothing. For example, the fol-
lowing code removes the btnHi control created by the first example.

Me.Controls.Remove (btnHi)
btnHi = Nothing

This code will also remove controls that you created interactively at design time, as well as controls you
create during run time.

Properties

A property is some value associated with a control. Often, a property corresponds in an obvious way one
of the control’s visual or behavioral features. For example, the Text property represents the text that the
control displays, BackColor represents the control’s background color, Top and Left represent the con-
trol’s position, and so forth.

Many properties, including Text, BackColor, Top, and Left, apply to many kinds of controls. Other
properties only work with certain specific types of controls. For example, the ToolStrip control has an
ImageList property that indicates the ImageList control containing the images the Toolstrip should
display.

You can manipulate a control’s properties interactively at design time or using code at run time.
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Properties at Design Time
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To modify a control’s properties at design time, open its form in the Form Designer and click on the con-
trol. The Properties window displays the control’s properties. Figure 2-5 shows the Properties window
displaying a Button control’s properties. For example, the control’s Text property has the value “Make
Hi Button”, and its TextAlign property (which determines where the button displays its text) is set to
MiddleCenter.

The drop-down at the top of the Properties window, just below the Properties title, indicates that this
control is named btnMakeHiButton and that it is of the System.Windows . Forms.Button class.

You can set many properties by clicking on a property’s value in the Properties window and then typing
the new value. This works with simple string values such as the controls’ name and Text property, and
it works with some other properties where typing a value makes some sense.

For example, the HScrollBar control (horizontal scrollbar) has Minimum, Maximum, and Value proper-
ties that determine the control’s minimum, maximum, and current values. You can click on those proper-
ties in the Properties window and enter new values. When you press the Enter key or move to another
property, the control validates the value you typed. If you entered a value that doesn’t make sense (for
example, if you typed “ABC” instead of a numeric value), the IDE reports the error and lets you fix it.

Properties
btnMakeHiButton SystemWindows.Forms.Button =
2
FlatAppearance -
FlatStyle Standard
Microsoft Sans Serif, 8.25pt _I
ForeColor - ControlText
GenerateMember True
Image [ (none)
ImageAlign MiddleCenter
Imagelndex |:| {none)
ImageKey [ (none)
ImageList {none)
Location 72,104
Locked False
Margin 3,3,3,3
Maximum$ize 0,0
MinimumsSize 0,0
Meodifiers Friend
Padding 0, 0,0,0
RightToLeft Ho
Size 104,23
Tabindex ] =
TabStop True
Tag
Text Make Hi Button =
Tt AL AL st
Font
The font used to display text in the control.

Figure 2-5: The Properties window lets you change a
control’s properties at design time.
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Compound Properties

A few properties have compound values. The Location property includes the X and Y coordinates of
the control’s upper-left corner. The Size property contains the control’s width and height. The Font
property includes the font’s name, size, boldness, and other font properties.

The Properties window displays these properties with a plus sign on the left. If you click the plus sign,
the window expands the property to show the values that it contains. Figure 2-6 shows the same
Properties window shown in Figure 2-5 with the Font and Location properties expanded. You can
click on these subvalues and set them independently just as you can set any other property value.

When you expand a compound property, a minus sign appears to the left (see the Font and Location
properties in Figure 2-6). Click this minus sign to collapse the property and hide its members.

In some cases, you can also set a compound property’s values in a single step. The Location property
shown in Figure 2-6 has the value “8, 8.” You can type a new value (say, “16, 8”) directly into the
Property window.

Properties [ ]
btnMakeHiButton System.Windows.Forms.Button =
il
FlatAppearance -
FlatStyle Standard
=] _ Microsoft Sans Serif, §.25pt _I
Hame Eill Microsoft Sans Serif
Size 8.25
Unit Point
Bold False
GdiCharSet 0
GdiVerticalFont False
Italic False
Strikeout False
Underline False
ForeColor - ControlText
GenerateMember True
Image [ (none)
ImageAlign MiddleCenter
Imagelndex |:| {none) [
ImageKey [ (none)
ImageList {none}
E Location 72,104
X T2
¥ 104
Locked False =
= i 2 2 2 2
Font
The font used to display text in the control.

Figure 2-6: The Properties window lets you change even
complex properties at design time.
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Some compound properties provide more sophisticated methods for setting the property’s values. If you
click the ellipsis button to the right of the Font property shown in Figure 2-6, the IDE presents the font
selection dialog shown in Figure 2-7. You can use this dialog to set many of the font’s properties.

Font
Farit: Fant style:
ki ft 5 |F|egular
Italic
()} Maonatype Carziva Bold
€} MS Outlook Bald ltalic
g MS Fieference Sans 5—
M5 Reference Special
B MT Exka LI
- Effects ~ Sample
I Shikeout AaBby
™ Underline e
Script:
IWestern ;I

Figure 2-7: The Font property displays a dialog that lets
you set the font’s properties.

Restricted Properties

Some properties allow more restricted values. For example, the Visible property is a Boolean, so it can
only take the values True and False. If you click on the property, a drop-down arrow appears on the
right. If you click this arrow, the window displays a drop-down list where you can select one of the
choices, True or False.

Many properties have enumerated values. The Button control’s FlatStyle property allows the values
Flat, Popup, Standard, and System. If you click the drop-down arrow to the right of this property,
you'll see the list shown in Figure 2-8. You can select a new value from this list.

You can also double-click on the property to cycle through its allowed values. After you select a prop-
erty, you can use the up and down arrows to move through the values.

Some properties determine at any given moment exactly what values they can take. For example, some
properties contain references to other controls. The Button control’s ImageList property is a reference
to an ImageList component that contains the picture that the But ton control should display. If you
click the drop-down arrow to the right of this value, the Properties window displays a list of the
ImageList components on the form that you might use for this property. This list also contains the
entry (none), which you can select to remove any previous control reference in the property.

78



Controls in General

btnMakeHiButton System.Windows.Forms.Button e
FlatAppearance -
Standard ;I
E Font
Hame
Size
Unit
Bold
GdiCharSet L]
GdiVerticalFont False
Italic False
Strikeout False
Underline False
ForeColor Il ControlText
GenerateMember True
Image [ (none)
ImageAlign MiddleCenter
Imagelndex I:l {none}
ImageKey [ (none)
ImageList {none}
El Lecation 72,104
X T2
Y 104
8 Lo e -
FlatStyle
Determines the appearance of the control when a user moves
the mouse over the control and clicks.

Figure 2-8: Some properties provide an enumerated
list of allowed value.

Many properties take very specialized values and provide specialized property editors to let you select
values easily. For example, the Anchor property lets you anchor a control’s edges to the edges of its con-
tainer. Normally, a control is anchored to the top and left edges of the container so that it remains in the
same position even if the container is resized. If you also anchor the control on the right, its right edge
moves in or out as the container gets wider or narrower. This lets you make controls that resize with
their containers in certain useful ways.

If you select the Anchor property and click the drop-down arrow on the right, the Properties window
displays the small graphical editor shown in Figure 2-9. Click on the skinny rectangles on the left, top,
right, or bottom to anchor or unanchor the control on those sides. Press the Enter key to accept your
choices or press Escape to cancel them.

79



Chapter 2

Properties ]
btnMakeHiButton System.Windows.Forms.Button Rl

| »

(DataBindings)
{Hame) btnMakeHiButton
AccessibleDescription
AccessibleHame

AccessibleRole Default
AllowDrop False
Top, Left LI
AutoEllipsis
AutoSize il

AutoSizeMode |
BackColor

Backgroundimage
BackgroundimageL ayou

CausesValidation True

ContextMenuStrip {none}

Cursor Default

DialogResult Hone

Dock Hone

Enabled True
FlatAppearance

FlatStyle Standard
= Font Microsoft Sans Serif, 8.25pt

I i £ Corif

Anchor

Defines the edges of the container to which a certain control is
bound. When a control is anchored to an edge, the distance b...

Figure 2-9: Some properties, such as Anchor, provide
specialized editors to let you select their values.

Other complex properties may provide other editors. These are generally self-explanatory. Click the ellip-
sis or drop-down arrow to the right of a property value, and experiment to see how these editors work.

You can right-click any property and select Reset from its context menu to reset the property to a default
value. Many complex properties can take the value “(none),” and for those properties, selecting Reset
usually sets the value to “(none).”

Collection Properties
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Some properties represent collections of objects. For example, the ListBox control displays a list of
items. Its Items property is a collection containing those items. The Properties window displays the
value of this property as “(Collection).” If you select this property and click the ellipsis to the right, the
Properties window displays a simple dialog where you can edit the text displayed by the control’s items.
This dialog is quite straightforward: Enter the items’ text on separate lines and click OK.

Other properties are much more complex. For example, to create a TabControl that displays images on
its tabs, you must also create an ImageList component. Select the ImageList’s Images property, and
click the ellipsis to the right to display the dialog shown in Figure 2-10. When you click the Add button,
the dialog displays a file selection dialog that lets you add an image file to the control. The list on the left
shows you the images you have loaded and includes a small thumbnail picture of each image. The val-
ues on the right show you the images’ properties.
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Members:

Images Collection Editor

0|[&] small_book.bmp

2|[£2] group.bmp
3|[=] person.bmp

Remove

factory.bmp properties:

B Mise
HorizontalResolutic 96.01199

Hame
PhysicalDimension
PixelFormat
RawFormat
Size

factory.bmp

16, 16

Format24bppRghb

Bmip
16, 16

VerticalResolution | 96.01199

o]

Cancel

i)

Figure 2-10: This dialog lets you load images into an ImageList control

at design time.

After you add pictures to the ImageList control, create a TabControl. Select its ImageList property,
click the drop-down arrow on the right, and select the ImageList control you created. Next, select the
TabControl’s TabPages property, and click the ellipsis on the right to see the dialog shown in Figure 2-11.

Members:

TabPage Collection Editor

0| TabPage1
] TabPage2?
2| TabPage3
3| TabPaged

Bemove

TabPage2 properties:

2]

Maodifiers
SnapToGrid
Focus
Causes\Validation
Layout

AutoScroll
AutoScrollMar gin
AutoScrollMinSize
Margin

Padding

Size

B Miss

ImageKey
ToolTipText

o

o

HHEEBE

Friend
True

True

False
0.0

0,0
3,333
3333
264, 157

Figure 2-11: This dialog lets you edit a TabControl’s tab pages.
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Select a tab page, click on its ImageIndex property, click the drop-down arrow to the right, and pick the
number of the image in the ImageList that you want to use for this tab. Figure 2-12 shows the result.

Some properties even contain a collection of objects, each of which contains a collection of objects. For
example, the ListView control has an Items property that is a collection. Each item in that collection is
an object that has a SubItems property, which is itself a collection. When you display the ListView con-
trol as a list with details, an object in the Items collection represents a row in the view and the SubItems
property represents the secondary values in a row.

To set these values at design time, select the control and click the ellipsis to the right of the control’s
Items property in the Properties window. Create an item in the editor, and click the ellipsis to the right
of the item’s SubItems property. Figure 2-13 shows these editors in action. The one in the back is the
Items editor; the one in front is the subItems editor.

Other complicated properties provide similarly complex editors. While they may implement involved
relationships among various controls and components, they are usually easy enough to figure out with a
little experimentation.

@0 UselmageTabs - Microsoft Visual Studio
File Edit View Project Build Debug Data Format Tools Window Community Help
o p Debug = Any CPU - | i
-2
B M| e &F &Y o | OF] ]| 6 W B S
& Ly =1 1 a8 | S
= 17 “Formi.ub [Design]' | X ﬁ"JJ
ol = 5 = m 'E_=I = . allew
= = * i | £ e ;
o : i " Form1 =1 E3 =
£l 9 # & Eire ; :
g m
Bl > = A A EI 3 b = g
& N e SN G s .
2 k) iz |
a2 S O o) g e i
T
© & & 2 ol [ e g
..... o =
o= bl w7 Gy @ 3
= OE A A
> A e R m
® 85 bl b =
.=} ImageList1
|_:j Error List| 7] Task Lis‘t|>_'| COnlm:‘lll(l\'\ﬁlldOW|4ﬂ_. Bookmnrksl_—"l Output] —]Immediate W’ln(low|
Ready 4

Figure 2-12: A TabControl displays the images in an ImageList component on its tabs.

82



Controls in General

m ListViewSubltem Collection Editor

File
; Members: ListViewSubltem: {Sergio Aragones} propert...
: j (] ListViewSubltem:{Sergio Aragones] s El | =
HE= ] 1| ListViewSubltem: {Terry Pratchett} =
— 2| ListWiewSubltem: {Eoin Colfer} Ll El Data
B Tag
E B Misc
:: BackColor |:| Window
=] Font Microsoft Sans Serif, 8.2
H ForeColor - WindowText
& Hame ListViewSubltem3 pperties:
P Sergio Aragones
>§ |
- Microsoft Sans Serif, | &
2
% - WindowText
2
! | _}I Su True
Add Bemove |
{none)
I—I [ (none)
2l Al | [ (none)
- [ (none)
= ]
Subltems {Collection)
Tag
E Display
Add Remove IndentCount L] Py
0K Cancel
|_,-j Error List| | Task L|st|:| Coor M e o e e .
Ready

Figure 2-13: The objects in the Listview control’s Items collection each have a SubItems property,
which is also a collection.

Properties at Run Time

Visual Basic lets you set most control properties at design time, but often you will need to view and
modify property values at run time. For example, you might need to change a label’s text to tell the user
that something has changed, disable a button because it is not applicable at a particular moment, or read
the value selected by the user from a list.

As far as your code is concerned, a property is just like any other public variable defined by an object.
You get or set a property by using the name of the control, followed by a dot, followed by the name of
the property. For example, the following code examines the text in the TextBox named txtPath. If the
text doesn’t end with a / character, the code adds one. This code both reads and sets the Text property.

If Not txtPath.Text.EndsWith("/") Then txtPath.Text &= "/"

If a property contains a reference to an object, you can use the object’s properties and methods in your
code. The following code displays a message box indicating whether the txtPath control’s font is bold.

It examines the TextBox’s Font property. That property returns a reference to a Font object that has a
Bold property.
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If txtPath.Font.Bold Then
MessageBox.Show ("Bold")
Else
MessageBox.Show ("Not Bold")
End If

Note that a Font object’s properties are read-only, so the code cannot set the value of txtPath.Font
.Bold. To change the TextBox control’s font, the code would need to create a new font as shown in the
following code. This code passes the Font object’s constructor a copy of the TextBox control’s current
font to use as a template, and a value indicating that the new font should be bold.

txtPath.Font = New Font (txtPath.Font, FontStyle.Bold)

If a property represents a collection or array, you can loop through or iterate over the property just as if it
were declared as a normal collection or array. The following code lists the items the user has selected in
the ListBox control named 1stChoices. (If the ListBox control’s SelectionMode property is set to
MuliExtended, the user can select any or all of the items.)

For Each selected_item As Object In lstChoices.SelectedItems()
Debug.WriteLine (selected_item.ToString)
Next selected_item

A few properties are read-only at run time, so your code can examine them but not change their values.
For example, a Panel control’s Controls property returns a collection holding references to the controls
inside the Panel. This property is read-only at run time so you cannot set it equal to a new collection.
Note that the collection provides methods for adding and removing controls so you don’t really need to
replace the whole collection, you can change the controls that it contains instead.

Note also that at design time, this collection doesn’t appear in the Properties window. Instead of explic-
itly working with the collection, you add and remove controls interactively by dropping them in and out
of the Panel control.

A control’s Bottom property is also read-only and not shown in the Properties window. It represents the
distance between the top of the control’s container and the control’s bottom edge. This value is really
just the control’s Top property plus its Height property (control.Bottom = control.Top + control.
Height), so you can modify it using those properties instead of setting the Bot tom property directly.

In theory, a property can also be write-only at run time. Such a property is really more like a method
than a property, however, so most controls use a method instead. In practice, read-only properties are
uncommon and write-only properties are extremely rare.

Useful Control Properties
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Appendix A, “Useful Control Properties, Methods, and Events,” summarizes the Control class’s most
important properties.

All controls (including the Form control) inherit directly or indirectly from the Control class. That
means they inherit the Control class’s properties, methods, and events, unless they take action to over-
ride the Control class’s behavior.
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While these properties are available to all controls that inherit from the Control class, many are consid-
ered “advanced,” so they are not shown by the IntelliSense pop-up’s Common tab. For example, a pro-
gram is intended to set a control’s position by using its Location property not its Left and Top
properties, so Location is in the Common tab while Left and Top are only in the Advanced tab.

Figure 2-14 shows the Common tab on the IntelliSense pop-up for a Label control. It shows the Location
property but not the Left property. If you click on the All tab, you can see Left and the other advanced
properties. If you type the control’s name and enough of the string Left to differentiate it from the
Location property (in this case 1blDirectory.Le), the pop-up automatically switches to the All tab.

Many of the properties described in the previous list are straightforward, but a few deserve special
attention. The following sections describe some of the more confusing properties in greater detail.

Anchor and Dock

The Anchor and Dock properties allow a control to automatically resize itself when its container is
resized. The Anchor property determines which of the controls edges should remain a fixed distance
from the corresponding edges of the container.

@0 UseProperties - Microsoft Visual Studio
File Edit WView Project Build Debug Data Tools Window Community Help
-S| %Al 9 S-FE b bebug - AnyCPU - | 2 i
ARbh eS| =2 0PH BE &5 ";.-E.
L:'_'u i “Formt.vb' | Formi.ub [Design]*| - X E
=] " @
¥ Buttond = | | & Click =l e
g. I > J | > J £
g: 1 Publice Class Formil = 5
l 3 Private Sub Buttonl Click(ByVal sender is System.Chject, ByVal e L= Zystem.Eve %
. 4 If Mot txtPath.Text.EndsWith("/") Then txtPath.Text &= " /" z
% 5 -
§' 6 lolbirectory.Le| g
= 7 - " ]
g 7 LayoutEngine ] 3
= =1 If t.xtPathﬁ? Left =
. ]
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13 ¢ Modifierkeys —!
14 txtPath.Fo 2 MouseButtons tStyle.Bold)
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17 Debug. Common All ey
1s Next sSelecTeEt ICEM
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Figure 2-14: The Location property is on the IntelliSense Common tab but the Left property is not.
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For example, normally a control’s Anchor property is set to Top, Left. That means the control’s top and
left positions remain fixed when the container resizes. If the control’s upper-left corner is at the point
(8, 16) initially, it remains at the position (8, 16) when you resize the container. This is the normal control
behavior, and it makes the control appear fixed on the container.

For another example, suppose that you set a control’s Anchor property to Top, Right, and you place
the control in the container’s upper-right corner. When you resize the container, the control moves, so it
remains in the upper-right corner.

If you set two opposite Anchor values, the control resizes itself to satisfy them both. For example, sup-
pose that you make a button that starts 8 pixels from its container’s left, right, and top edges. Then sup-
pose that you set the control’s Anchor property to Top, Left, Right. When you resize the container, the
control resizes itself so that it is always 8 pixels from the container’s left, right, and top edges.

In a more common scenario, you can place Label controls on the left with Anchor set to Top, Left so
they remain fixed on the form. On the right, you can place TextBoxes and other controls with Anchor
set to Top, Left, Right, so they resize themselves to take advantage of the resizing form’s new width.

Figure 2-15 shows a New Customer dialog. The Labels, state ComboBox, and ZIP code TextBox con-
trols all have Anchor set to Top, Left so they do not move when the form resizes. The two buttons have
Anchor set to Top, Right, so they keep their positions relative to the upper-right corner of the form. The
First Name, Last Name, Street, and City TextBox controls have Anchor set to Top, Left, Right, so
they resize themselves to fill in whatever space is between the labels and the buttons. This arrangement
lets the TextBox controls use as much of the form’s available space as possible. The Anchor properties
are set at design time and do all the work automatically, so you don’t need to write any extra code to
rearrange the controls at run time.

New Customer [_]O]
First Marme IFh:u:I

Last Mame |Stephens
Streat |1 234 Programmer PI

City IEugwiIIe
State [Co w| 2R [12345.6789

Figure 2-15: This dialog uses Anchor
properties to make its TextBox controls
use whatever space is available on the form.

Similarly, you can make controls that stretch vertically as the form resizes. Figure 2-16 shows a form list-
ing customer orders. The upper ListView control has Anchor set to Top, Left, Right, so it keeps its ini-
tial height and fills the width of the form. The bottom ListView has Anchor set to Top, Bottom, Left,
Right. It fills the width of the form and fills the form from its initial Top position to the bottom of the
form. If the user makes the form taller, the control resizes itself to use the available space.
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Customer Orders M=l E3

Cuztomer

Adam Arken B
Betty Baker

Dan Deevers ;I
Orders

B, reams paper

1, 17" flat panel monitar

1. 17.5 GHz 65-bit MightyQuick computer
1. Egonomic keyboard

10, enail finger mice

Figure 2-16: The bottom ListVview control
resizes itself to use up any extra vertical
space on the form.

If you do not provide any Anchor value for either the vertical or horizontal directions, the control
anchors its center to the container’s center. For example, suppose that you position a button in the bot-
tom middle of the form and you set Anchor to Bottom (omitting Left and Right). Because you placed
the control in the middle of the form, the control’s center coincides with the form’s center. When you
resize the form, the control moves so it remains centered horizontally.

If you place other controls on either side of the centered one, they will all move so they remain together
centered as a group as the form resizes. Figure 2-17 shows a form containing a group of controls with
Anchor set to Bottom. You may want to experiment with this property to see the effect.

Centered Group H=]

et | Migde | mignt |

Figure 2-17: Controls with Anchor set to
Bottom remain centered as a group.

At run time, you can set a control’s Anchor property to AnchorStyles.None or to a Boolean com-
bination of the values AnchorStyles.Top, AnchorStyles.Bottom, AnchorStyles.Left, and
AnchorStyles.Right. For example, the following code moves the Buttonl control to the form’s
lower-right corner and sets its Anchor property to Bottom, Right, so it stays there.
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Private Sub Forml_Load(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles MyBase.Load
Buttonl.Location = New Point( _
Me.ClientRectangle.Width - Buttonl.Width, _
Me.ClientRectangle.Height - Buttonl.Height)
Buttonl.Anchor = AnchorStyles.Bottom Or AnchorStyles.Right
End Sub

Dock

The Dock property determines whether a control attaches itself to one or more of its container’s sides.
For example, if you set a control’s Dock property to Top, the control docks to the top of its container. It
fills the container from left to right and is flush with the top of the container. If the container is resized,
the control remains at the top, keeps its height, and resizes itself to fill the container’s width. This is how
a typical toolbar behaves. The effect is similar to placing the control at the top of the container so that it
fills the container’s width and then setting the Anchor property to Top, Left, Right.

You can set a control’s Dock property to Top, Bottom, Left, Right, Fill, or None. The value Fill
makes the control dock to all of its container’s remaining interior space. If it is the only control in the
container, that makes it fill the whole container.

If the container holds more than one control with Dock set to a value other than None, the controls are
arranged according to their stacking order (also called the Z-order). The control that is first in the stack-
ing order (would normally be drawn first at the back) is positioned first using its Dock value. The con-
trol that comes next in the stacking order is arranged second, and so on until all of the controls are
positioned.

Figure 2-18 shows four TextBoxes with Dock set to different values. The first in the stacking order has
Dock set to Left so it occupies the left edge of the form. The next control has Dock set to Top, so it occu-
pies the top edge of the form’s remaining area. The third control has Dock set to Right, so it occupies the
right edge of the form’s remaining area. Finally, the last control has Dock set to Fill so it fills the rest of
the form.

First Second

Faurth Third

Figure 2-18: Controls with Dock not equal to None
are arranged according to their stacking order.

Controls docked to an edge resize to fill the container in one dimension. For example, a control with
Dock set to Top fills whatever width the container has available. A control with Dock set to Fi11 resizes
to fill all of the form’s available space.
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Other than that, the Dock property does not arrange controls very intelligently when you resize the con-
tainer. For example, suppose that you have two controls, one above the other. The first has Dock set to
Top and the second has Dock set to Fill. You can arrange the controls so that they evenly divide the
form vertically. When you make the form taller, however, the second control, with Dock set to Fi11,
takes up all of the new space, and the other control remains the same size.

You cannot use the Dock property to make the controls divide the form evenly when it is resized. You
cannot use the Anchor property to evenly divide the form either. Instead, you need to use code similar
to the following. When the form resizes, this code moves and sizes the two controls TextBox1 and
TextBox2 to fill the form, evenly dividing it vertically.

Private Sub Forml_Load(ByVal sender As Object, _

ByVal e As System.EventArgs) Handles Me.Load
ArrangeTextBoxes ()

End Sub

Private Sub Forml_Resize (ByVal sender As Object, _

ByVal e As System.EventArgs) Handles Me.Resize
ArrangeTextBoxes ()

End Sub

Private Sub ArrangeTextBoxes ()
Dim wid As Integer = Me.ClientRectangle.Width
Dim hgtl As Integer = Me.ClientRectangle.Height \ 2
Dim hgt2 As Integer = Me.ClientRectangle.Height - hgtl
TextBoxl.SetBounds (0, 0, wid, hgtl)
TextBox2.SetBounds (0, hgtl, wid, hgt2)

End Sub

When you want to divide a form, the SplitterContainer control can also be useful. The
SplitterContainer contains two panels that can hold other controls. The user can drag the divider
between the two panels to adjust the size allocated to each.

Position and Size Properties

Controls contain many position and size properties, and the differences among them can be confusing.
Some of the more bewildering aspects of controls are the ideas of client area, nonclient area, and
display area.

A control’s client area is the area inside the control where you can draw things or place other controls. A
control’s nonclient area is everything else. In a typical form, the borders, title bar, and menus are the non-
client area. The client area is the space inside the borders and below the menus where you can place con-
trols or draw graphics.

A control’s display area is the client area minus any internal decoration. For example, a GroupBox control
displays an internal border and a title. While you can place controls over these, you normally wouldn't.
The display area contains the space inside the GroupBox ' s borders and below the space where the

title sits.

The following table describes properties related to the control’s size and position.
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Property Data Type Read/Write Purpose

Bounds Rectangle Read/Write The control’s size and position
within its container including non-
client areas.

ClientRectangle Rectangle Read The size and position of the client
area within the control.

ClientSize Size Read /Write The size of the client area. If you
set this value, the control adjusts its
size to make room for the nonclient
area, while giving you this client
size.

DisplayRectangle Rectangle Read The size and position of the area
within the control where you
would normally draw or place
other controls.

Location Point Read /Write The position of the control’s upper-
left corner within its container.

Size Point Read /Write The control’s size including non-
client areas.

Left, Top, Width, Integer Read/Write The control’s size and position
Height within its container including
nonclient areas.

Bottom, Right Integer Read The position of the control’s lower-
right corner within its container.

Methods

A method executes code associated with a control. The method can be a function that returns a value or
a subroutine that does not return a value. Methods can take parameters just like any other function or
subroutine.

Because methods execute code, you cannot invoke them at design time. You can only invoke them using
code at run time.

Appendix A summarizes the Control class’s most important methods. Controls that inherit from the
Control class also inherit these methods unless they have overridden the Control class’s behavior.

Events

A control or other object raises an event to let the program know about some change in circumstances.
Sometimes raising an event is also called “firing” or “throwing” the event. Specific control classes
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provide events that are relevant to their special purposes. For example, the But ton control provides a
Click event to let the program know when the user clicks on the button.

The program responds to an event by creating an event handler that “catches” the event and takes what-
ever action is appropriate. Each event defines its own event-handler format and determines the parameters
that the event handler will receive. Often, these parameters give additional information about the event.

For example, when part of the form is covered and exposed, the form raises its Paint event. The Paint
event handler takes as a parameter an object of type PaintEventArgs. That object’s gr property is a ref-
erence to a Graphics object that the program can use to redraw the form’s contents.

Some event handlers take parameters that are used to send information about the event back to the
object that raised it. For example, the Form class’s FormClosing event handler has a parameter of type
FormClosingEventArgs. That parameter is an object with that has a property named cancel. If the
program sets Cancel to True, the Form cancels the FormClosing event and remains open. For example,
the event handler can verify that the data entered by the user was properly formatted. If the values didn’t
make sense, the program can display an error message and keep the form open.

While many of a control’s most useful events are specific to the control type, controls do inherit some
common events from the Control class. Appendix A summarizes the Control class’s most important
events. Controls that inherit from the Control class also inherit these events unless they have overrid-
den the Control class’s behavior.

Creating Event Handlers at Design Time

There are a couple of ways that you can create an event handler at design time. If you open a form in the
Form Designer and double-click on a control, the code editor opens and displays the control’s default
event handler. For example, a TextBox control opens its TextChanged event handler, a Button control
opens its Click event handler, and the form itself opens its Load event handler.

To create some other nondefault event handler for a control, open the code window;, select the control
from the left drop-down list, and then select the event handler from the right drop-down list, as shown
in Figure 2-19. To create an even handler for the form itself, select “(Form1 Events)” from the left drop-
down and then select an event from the right drop-down.

The code window creates an event handler with the correct parameters and return value. For example,
the following code shows an empty TextBox control’s Click event handler (note that the first two lines
are wrapped in this text and appear on one line in the code editor). Now you just need to fill in the code
that you want to execute when the event occurs.

Private Sub TextBoxl Click(ByVal sender As Object, ByVal e As System.EventArgs) _
Handles TextBoxl.Click

End Sub
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Figure 2-19: To create an event handler in the code window, select a control from the left drop-down,
and then select an event from the right drop-down.

WithEvents Event Handlers

If you declare an object variable using the withEvents keyword, you can catch its events. After you
declare the variable, you can select it in the code designer’s left drop-down, just as you can select any
other control. Then you can select one of the object’s events from the right drop-down.

When the code assigns an instance of an object to the variable, any event handlers defined for the vari-
able receive the object’s events.

Usually, you don’t need to create WithEvents variables for controls because Visual Basic does it for you.
However, using a variable declared withEvents lets you enable and disable events quickly and easily.
For example, suppose that a program wants to track a PictureBox’s mouse events at some times, but

not at others. It could declare a PictureBox variable as shown in the following code.

Private WithEvents m_Canvas As PictureBox
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When the program wants to receive events, it can set this variable equal to its PictureBox control as in
this code. Now the variable’s event handlers such as m_Canvas_MouseDown, m_Canvas_MouseMove,
and m_Canvas_MouseUp are enabled.

m_Canvas = PictureBoxl

When it no longer wants to receive these events, the program can set m_Canvas to Nothing as in the fol-
lowing statement. While m_Canvas is Nothing, it has no associated control to generate events for it.

m_Canvas = Nothing

Setting Event Handlers at Run Time

Not only can you create event handlers at design time, but you can also assign them at run time. First
create the event handler. You must get the routine’s parameters exactly correct for the type of event han-
dler you want to create. For example, a TextBox control’s C1ick event handler must take two parame-
ters with types System.Object and System.EventArgs.

To ensure that you get the details right, you can start by creating an event handler for a normal control at
design time. Select the control from the code designer’s left drop-down, and then select the event from
the right. Change the resulting event handler’s name to something appropriate (for example, you might
change Buttonl_Click to ToolClicked) and remove the Handles statement that ties the event han-
dler to the control. You can also delete the original control if you don’t need it for anything else.

Now you can use the AddHandler and RemoveHandler statements to add and remove the event han-
dler from a control. The following code shows how a program can switch the event handler that a button
executes when it is clicked.

When RadioButtonl is checked or unchecked, its CheckedChanged event handler adds or removes the
ButtonHandlerl event handler from the Buttonl control’s Click event. Similarly, when RadioButton2
is checked or unchecked, its CheckedChanged event handler adds or removes the But tonHandler?2
event handler from the Buttonl control’s Click event.

The ButtonHandlerl and ButtonHandler2 event handlers simply display a message telling you
which is executing. The form’s Load event handler selects the first radio button.

' Add or remove ButtonHandlerl.
Private Sub RadioButtonl_CheckedChanged (ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles RadioButtonl.CheckedChanged
If RadioButtonl.Checked Then
AddHandler Buttonl.Click, AddressOf ButtonHandlerl
Else
RemoveHandler Buttonl.Click, AddressOf ButtonHandlerl
End If
End Sub

' Add or remove ButtonHandler2.
Private Sub RadioButton2_CheckedChanged (ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles RadioButton2.CheckedChanged

If RadioButton2.Checked Then
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AddHandler Buttonl.Click, AddressOf ButtonHandler2
Else
RemoveHandler Buttonl.Click, AddressOf ButtonHandler2
End If
End Sub

' Display a message telling which event handler this is.
Private Sub ButtonHandlerl (ByVal sender As System.Object, _
ByVal e As System.EventArgs)

MessageBox.Show ("ButtonHandlerl")
End Sub

Private Sub ButtonHandler2 (ByVal sender As System.Object, _
ByVal e As System.EventArgs)

MessageBox. Show ("ButtonHandler2")
End Sub

' Start with RadioButtonl selected.

Private Sub Forml_Load(ByVal sender As System.Object, _

ByVal e As System.EventArgs) Handles MyBase.Load
RadioButtonl.Checked = True

End Sub

You can also use AddHandler and RemoveHandler to enable and disable events as needed much as the
previous section showed how to enable and disable events using variables declared with the withEvents
keyword.

AddHandler and RemoveHandler allow you to switch one or two events relatively easily. If you must
switch many event handlers for the same control at once, however, it may be easier to use a variable
declared using the withEvents keyword.

Changing Design Time Event Handlers

An event handler you create for a particular control at design time is just like any other event handler
subroutine at run time. You can use RemoveHandler to detach it from the control’s events, and you can
use AddHandler to reattach it to an event.

Typically, an event handler that you create attached to a particular control seems different from those
you write separately from any control. It may follow different naming conventions (perhaps btnTool_
Click versus ToolClickEventHandler), and its declaration includes a Handles clause that a “hand-
coded” event-handling routine will not have.

This lack of symmetry may make switching these event handlers with those you create on your own a
bit confusing. On the other hand, using AddHandler and RemoveHandler to remove and reattach an
event handler is relatively straightforward. As long as you don’t mix and match the two kinds of event
handlers, this should cause no confusion.

Control “Array” Events

Visual Basic 6 and earlier versions allowed you to use control arrays. A control array was an array of con-
trols with the same name that shared the same event handlers. A parameter to the event handlers gave
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the index of the control in the array that fired the event. If the controls perform closely related tasks, the
common event handler may be able to share a lot of code for all of the controls. Visual Basic .NET does
not allow control arrays, but you can get similar effects in a couple of ways.

First, suppose that you add a control to a form and give it event handlers. Then you copy and paste the
control to make other controls on the form. All these controls share the event handlers you already cre-
ated by default. If you look at the event handlers’ code, you'll see the Handles statements list all of the
copied controls. You can also modify an event handler’s Handles clause manually to attach it to more
than one control.

Another way to make controls share event handlers is to attach them to the controls by using the
AddHandler statement.

An event handler’s first parameter is a variable of the type System.Object that contains a reference to
the object that raised the event. The program can use this object and its properties (for example, its Name
property) to determine which control raised the event and take appropriate action.

Validation Events

Data validation is an important part of many applications. Visual Basic provides two events to make val-
idating data easier: Validating and Validated.

The validating event fires when the code should validate a control’s data. This happens when the con-
trol has the input focus and the form tries to close, and when focus moves from the control to another
control that has Causesvalidation property set to True.

The Validation event handler can verify that the data in a control has a legal value and take appropriate
action if it doesn’t. For example, consider the form shown in Figure 2-20. The first TextBox’s Validating
event handler checks that the control’s value contains exactly five digits. If the value does not contain five
digits, as is the case in the figure, the program uses an ErrorProvider control to flag the TextBox’s
value as being in error and moves the input focus back to the TextBox. The ErrorProvider displays the
little exclamation mark icon to the right of the control and makes the icon blink several times to get the
user’s attention. If the user hovers the mouse over the icon, the ErrorProvider displays the error text in
a tooltip.

8 Validation

Five Digits |1 774 %

P | |TextBux1 must contain exactly five tligilst

Walidation | |

Figure 2-20: The validating event fires when the focus
moves to a control that has CausesvValidation set to True.

The second TextBox control in this example has a Causesvalidation property value of False. When
the user moves from the first TextBox control to the second one, the validating event does not fire
and the TextBox control is not flagged. The third TextBox control has Causesvalidation set to True
so, when the user moves into that TextBox control, the first TextBox’s Validating event fires, and the
value is flagged if it is invalid. The Validating event also fires if the user tries to close the form.
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The following code shows the validating event handler used by this example. Notice that the Handles
clause lists all three TextBoxes' Validating events so this event handler catches the validating event
for all three controls.

The event handler receives the control that raised the event in its sender parameter. It uses DirectCast

to convert that generic Object into a TextBox object and passes it to the ValidateFiveDigits subrou-

tine. It also passes the e.Cancel parameter, so the subroutine can cancel the action that caused the event
if necessary.

ValidateFiveDigits checks the TextBox's contents and sets its cancel_event parameter to True if
the text has nonzero length and is not exactly five digits. This parameter is passed by reference so this
changes the original value of e.Cancel in the calling event handler. That will restore focus to the
TextBox control that raised the event and that contains the invalid data.

If cancel_event is True, then the value is invalid so the program uses the ErrorProvider component
named ErrorProvider] to assign an error message to the TextBox control.

If cancel_event is False, then the value is valid so the program blanks the ErrorProvider's mes-
sage for the TextBox control.

The event handler receives the control that raised the event in its sender parameter. It uses DirectCast
to convert that generic Object into a TextBox object and passes it to the ValidateFiveDigits subrou-
tine. It also passes the e.Cancel parameter, so the subroutine can cancel the action that caused the event
if necessary.

ValidateFiveDigits checks the TextBox's contents and sets its cancel_event parameter to True if
the text has nonzero length and is not exactly five digits. This parameter is passed by reference, so this
changes the original value of e.Cancel in the calling event handler. That will restore focus to the
TextBox that raised the event and that contains the invalid data.

If cancel_event is True, the value is invalid, so the program uses the ErrorProvider component
named ErrorProviderl to assign an error message to the TextBox control.

If cancel_event is False, then the value is valid so the program blanks the ErrorProvider's mes-
sage for the TextBox.

' Validate the TextBox's contents.

Private Sub TextBoxl_Validating(ByVal sender As Object,

ByVal e As System.ComponentModel.CancelEventArgs)

Handles TextBoxl.Validating, TextBox2.Validating, TextBox3.Validating
' Get the TextBox.
Dim text_box As TextBox = DirectCast (sender, TextBox)

' Validate the control's value.
ValidateFiveDigits (text_box, e.Cancel)
End Sub

' Verify that the TextBox contains five digits.
Private Sub ValidateFiveDigits (ByVal text_box As TextBox,
ByRef cancel_event As Boolean)

If text_box.Text.Length = 0 Then
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' Allow a zero-length string.

cancel_event = False
Else

' Allow five digits.

cancel_event = Not (text_box.Text Like "#####")
End If

' See if we're going to cancel the event.
If cancel_event Then
' Invalid. Set an error.
ErrorProviderl.SetError (text_box, _
text_box.Name & " must contain exactly five digits")
Else
' Valid. Clear any error.
ErrorProviderl.SetError (text_box, "")
End If
End Sub

The event handler receives the control that raised the event in its sender parameter. It uses DirectCast
to convert that generic Object into a TextBox object and passes it to the ValidateFiveDigits subrou-
tine. It also passes the e.Cancel parameter, so the subroutine can cancel the action that caused the event
if necessary.

ValidateFiveDigits checks the TextBox's contents and sets its cancel_event parameter to True if
the text has nonzero length and is not exactly five digits. This parameter is passed by reference, so this
changes the original value of e.Cancel in the calling event handler. That will restore focus to the
TextBox that raised the event and that contains the invalid data.

If cancel_event is True, the value is invalid, so the program uses the ErrorProvider component
named ErrorProviderl to assign an error message to the TextBox control.

If cancel_event is False, then the value is valid so the program blanks the ErrorpProvider's mes-
sage for the TextBox control.

Separated Validation

A control’s Validated event fires after the focus successfully leaves the control, either to another control
with Causesvalidation set to True or when the form closes. The control should have already validated
its contents in its Validating event, hence the event name validated.

This event doesn’t really have anything directly to do with validation, however, and it fires whether or
not the code has a validating event handler and even if the control’s value is invalid. The only time it
will not execute is if the validation does not complete. That happens if the validating event handler
cancels the event causing the validation.

The previous section showed how to set or clear a control’s error in its Validating event handler. An
alternative strategy is to set errors in the validating event handler and clear them in the validated
event handler, as shown in the following code. If the control’s value is invalid, the validating event
handler cancels the event causing the validation so the Validated event does not occur. If the control’s
value is valid, the validating event handler does not cancel the event and the validated event han-
dler executes, clearing any previous error.
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' Validate the TextBox's contents.

Private Sub TextBoxl_Validating(ByVal sender As Object, _

ByVal e As System.ComponentModel.CancelEventArgs)

Handles TextBoxl.Validating, TextBox2.Validating, TextBox3.Validating
' Validate the control's value.
ValidateFiveDigits (DirectCast (sender, TextBox), e.Cancel)

End Sub

' Verify that the TextBox contains five digits.
Private Sub ValidateFiveDigits (ByVal text_box As TextBox,
ByRef cancel_event As Boolean)
' Cancel if nonzero length and not five digits.
cancel_event = (text_box.Text.Length <> 0) And _
Not (text_box.Text Like "#####")

' See if we're going to cancel the event.
If cancel_event Then
' Invalid. Set an error.
ErrorProviderl.SetError (text_box,
text_box.Name & " must contain exactly five digits")
End If
End Sub

' Validation succeeded. Clear any error.

Private Sub TextBoxl_ Validated(ByVal sender As Object,

ByVal e As System.EventArgs) _

Handles TextBoxl.Validated, TextBox2.Validated, TextBox3.Validated
' Valid. Clear any error.
ErrorProviderl.SetError (DirectCast (sender, TextBox), "")

End Sub

Deferred Validation

By keeping focus in the control that contains the error, the previous approaches force the user to fix
problems as soon as possible. In some applications, it may be better to let the user continue filling out
other fields and fix the problems later. For example, a user who is touch-typing data into a lot several
fields may not look up to see the error until much later, after failing to enter many values in the invalid
field and wasting a lot of time.

The following code shows one way to let the user continue entering values in other fields. The
validating event handler calls the validateFiveDigits subroutine much as before, but this time
ValidateFiveDigits does not take the cancel_event parameter. If the TextBox’s value has an error,
the routine uses the ErrorProvider to assigns an error message to it and exits.

When the user tries to close the form, the FormClosing event handler executes. This routine assumes that
some field contains invalid data, so it sets e.Cancel to True. It then calls function IsInvalidField for
each of the controls that it wants to validate. If IsInvalidField returns True, the event handler exits,
e.Cancel remains True, and the form refuses to close. If all of the fields pass validation, then the event
handler sets e.Cancel to False, and the form closes.

Function IsInvalidField uses the ErrorProvider’s GetError method to get a control’s assigned
error message. If the message is blank, the function returns False to indicate that the control’s data is
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valid. If the message is not blank, then the function displays it in a message box, sets focus to the control,
and returns True to indicate that the data is invalid.

When the user tries to close the form, the FormClosing event handler executes. This routine assumes that
some field contains invalid data, so it sets e.Cancel to True. It then calls function IsInvalidrField for
each of the controls that it wants to validate. If IsInvalidField returns True, the event handler exits,
e.Cancel remains True, and the form refuses to close. If all of the fields pass validation, the event han-
dler sets e.Cancel to False, and the form closes.

Function IsInvalidrField uses the ErrorProvider's GetError method to get a control’s assigned
error message. If the message is blank, then the function returns False to indicate that the control’s data
is valid. If the message is not blank, then the function displays it in a message box, sets focus to the con-
trol, and returns True to indicate that the data is invalid.

' Validate the TextBox's contents.

Private Sub TextBoxl Validating(ByVal sender As Object,

ByVal e As System.ComponentModel.CancelEventArgs)

Handles TextBoxl.Validating, TextBox2.Validating, TextBox3.Validating
' Validate the control's value.
ValidateFiveDigits (DirectCast (sender, TextBox))

End Sub

' Verify that the TextBox contains five digits.
Private Sub ValidateFiveDigits (ByVal text_box As TextBox)
' See if the data is valid.
If (text_box.Text.Length <> 0) And _
Not (text_box.Text Like "#####")
Then
' Invalid. Set an error.
ErrorProviderl.SetError (text_box, _
text_box.Name & " must contain exactly five digits")
Else
' Valid. Clear the error.
ErrorProviderl.SetError (text_box, "")
End If
End Sub

' See if any fields have error messages.

Private Sub Forml_FormClosing(ByVal sender As Object, _
ByVal e As System.Windows.Forms.FormClosingEventArgs)
Handles Me.FormClosing

' Assume we will cancel the close.
e.Cancel = True

' Check for errors.

If IsInvalidField(TextBoxl) Then Exit Sub
If IsInvalidField(TextBox3) Then Exit Sub
' If we got this far, the data's okay.
e.Cancel = False

End Sub

' If this control has an error message assigned to it,
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' display the message, set focus to the control,
' and return True.
Private Function IsInvalidField(ByVal ctl As Control) As Boolean
' See if the control has an associated error message.
If ErrorProviderl.GetError (ctl).Length = 0 Then
' No error message.
Return False
Else
' There is an error message.
' Display the message.
MessageBox.Show (ErrorProviderl.GetError (ctl))

' Set focus to the control.
ctl.Focus ()
Return True
End If
End Function

When the user tries to close the form, the FormClosing event handler executes. This routine assumes
that some field contains invalid data so it sets e.Cancel to True. It then calls function IsInvalidField
for each of the controls that it wants to validate. If IsInvalidField returns True, the event handler
exits, e. Cancel remains True, and the form refuses to close. If all of the fields pass validation, the event
handler sets e.Cancel to False, and the form closes.

The function IsInvalidField uses the ErrorProvider's GetError method to get a control’s
assigned error message. If the message is blank, the function returns False to indicate that the control’s
data is valid. If the message is not blank, then the function displays it in a message box, sets focus to the
control, and returns True to indicate that the data is invalid.

If the focus is in a TextBox when the form tries to close, its Validating event fires before the form’s
FormClosing event so the TextBox control has a chance to validate its contents before the
FormClosing event fires.

Summary

This chapter describes controls, components, and objects in general terms. It tells how to create controls
and how to use their properties, methods, and events. It spends some extra time on data-validation
events, as well as adding and removing event handlers.

Appendix A, “Useful Control Properties, Methods, and Events,” describes the most useful properties,
methods, and events provided by the Control class. All controls that inherit from this class also inherit

these properties, methods, and events, unless they take action to override the Control class’s behavior.

Appendix G, “Standard Controls and Components,” describes the standard Windows controls in detail.
This appendix can help you understand the controls and decide which is best for a particular situation.
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This chapter gives some useful background for working with controls in general, but there’s more to
building a Visual Basic application than just controls. You also need to understand the code behind the
controls that lets the program take values from controls, manipulate those values, and display a result in
the controls. The next several chapters cover these topics in detail. Chapter 3, “Program and Module
Structure,” starts the process by explaining the files that make up a Visual Basic project and the structure
contained within code files.
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Program and Module
Structure

A Visual Basic solution contains one or more related projects. A project contains files related to
some topic. Usually, a project produces some kind compiled output (such as an executable pro-
gram, class library, control library, and so forth). The project includes all the files related to the out-
put, including source code files, resource files, documentation files, and whatever other kinds of
files you decide to add to it.

This chapter describes the basic structure of a Visual Basic project. It explains the functions of
some of the most common files and tells how you can use them to manage your applications.

This chapter also explains the basic structure of source code files. It explains regions, namespaces,
and modules. It also describes some simple typographic features provided by Visual Basic such as
comments, line continuation, and line labels. These features do not execute programming com-
mands themselves, but they are an important part of how you can structure your code.

Hidden Files

Figure 3-1 shows the Solution Explorer window for a solution that contains two projects.

The solution named MySolution contains two projects named WindowsApplicationl and
WindowsApplication2. Each project contains a My Project item that represents the project’s prop-
erties, an app . config file containing project configuration settings, and a form named Form1.
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Solution Explorer - WindowsApplication2
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-3 System.Drawing
< System.Windows.Forms
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"E] ApplicationEvents.vh

= [ Form1.wb
i %] Form1.Designer.vb

Figure 3-1: A solution contains one or more projects
that contain files.

In WindowsApplication2, the Show Hidden Files button has been pushed (the second button from the
left with the box around it) so that you can see all the project’s files. WindowsApplication] has similar
files, but they are hidden by default.

These files are generated by Visual Basic for various purposes. For example, Resources. resx contains
resources used by the project and Settings.settings contains project settings.

Resources are chunks of data that are distributed with the application but that are not intended to be
modified by the program. These might include prompt strings, error message strings, icons, and sound
files. For example, resources are commonly used for customizing applications for different languages.
You build different resource files for different languages, and the program loads its prompts and error
messages from the appropriate resource file. Chapter 25,” Configuration and Resources,” has more to
say about resources.

Settings are values that control the execution of the application. These might include flags telling the pro-
gram what options to display or how to perform certain tasks. For example, you could build different pro-
files to provide settings that make the program run in a restricted demo mode or in a fully licensed mode.

The following list describes the files contained in WindowsApplication2 and shown in Figure 3-1. The
types of files generated for a project changed a bit between some of the early versions of Visual Studio
2005, so the exact files you see may be different from those shown here. This list should give you an idea
of what’s involved in building a project, however.
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WindowsApplication2 — This folder represents the entire project. You can expand or collapse it
to show and hide the project’s details.

My Project — This folder represents the project’s assembly information, application-level events,
resources, and configuration settings. Double-click the My project entry to view and edit these
values.

Application.myapp — This XML file defines application properties (such as whether it’s
a single instance program and whether its shutdown mode is AfterMainFormCloses or
AfterAllFormsClose).

Application.Designer.vb — This file contains code that works with the values defined in
Application.myapp.

AssemblyInfo.vb — This file contains information about the application’s assembly such as
copyright information, company name, trademark information, and assembly version.

Resources.resx — This resource file contains project’s resources.

Resources.Designer.vb — This file contains Visual Basic code for manipulating resources
defined in Resources. resx. For example, if you define a string resource named Greeting in
Resources.resx, Visual Basic adds a read-only property to this module so you can read the
value of Greeting as shown in the following code.

MessageBox.Show (My .Resources.Greeting)

Settings.settings — This file contains settings that you can define to control the application.

Settings.Desginer.vb — This file contains Visual Basic code for manipulating settings
defined in Settings.settings, much as Resources.Designer.vb contains code for working
with Resources. resx. For example, the following code uses the UserLevel setting.

If My.Settings.UserMode = "Clerk" Then ...

Q

References — This folder lists references to external components such as DLLs and COM
components.

bin — This folder is used to build the application before it is executed. It contains the compiled
.exe file.

obj — This folder is used to build the application before it is executed.

app.config — This XML file contains configuration information for the application. It
includes the information in MySettings.settings.

ApplicationEvents.vb — This code file contains application-level event handlers for the
MyApplication object. For example, it contains the application’s Startup, Shutdown, and
NetworkAvailabilityChanged event handlers.

Forml.vb — This is a form file. It contains the code you write for the form, its controls, their
event handlers, and so forth.

Forml.Designer.vb — This file contains designer-generated Visual Basic code that builds the
form. It initializes the form when it is created, adds the controls you placed on the form, and
defines variables with the withEvents keyword for the controls so that you can easily catch
their events.
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Some projects may have other hidden files. For example, when you add controls to a form, the designer
adds a resourece file to the form to hold any resources needed by the controls.

Normally, you do not need to work directly with the hidden files. You can use other tools to modify
them indirectly instead. For example, the files Resources.Designer.vb, Settings.Designer.vb,
and Forml .Designer.vb are automatically generated when you modify their corresponding source
files Resources.resx, Settings.settings, and Forml.vb.

You don’t even need to work with all of these source files directly. For example, if you double-click the
My Project item, the property pages shown in Figure 3-2 appear. The Application tab shown in this fig-
ure lets you set high-level application settings such as the shutdown mode (stored in Application
.myapp). The View Code button scrolled off the bottom of the figure lets you edit the application-level
events stored in ApplicationEvents.vb.

The Resources tab shown in Figure 3-2 lets you view, add, and remove project references. As you can
probably guess, the Resources and Settings tabs let you edit the project’s resources and settings.

A particularly important section hidden away in these tabs is the assembly information. If you click the
Assembly Information button shown in Figure 3-2, the dialog shown in Figure 3-3 appears.

@0 MySolution - Microsoft Visual Studio
File Edit VYiew Project Build Debug Data Tools Window Community Help
-S| 4 BRBR|9--E-B | b Debug ~ Any CPU - | 2 &
R | f"'Win(IowsApplication?rForm1.ub [Design]] Formt.ub [Design]| ~ X E
=] 13
8 g
Application =
w
2 Configuration: |II-A j Platforme: III-A j %
E Compile =
= g
. : - =
1. Debug Assembly name: Root namespace: = i
>§ ! ndowsApplication2 IMl1(IowsA|)|}licati0|12
= |
= References . L%
E Application type: leon: h]
=
R Win Applicati - Default | - E =
Resources I indows Application J I{ efault lcon) _I H
Settings Startup form: 3;
IForm1 j Assembly Information... |
Signing
[+ Enable application framework Lo
Security
Publish Windows application framework properties
=S [¥ Enable XP visual styles
.-h"'w-___ [~ Make single instance application
[v Save My.Settings on Shutdown il
| | »
|_fj Error List| <] Task List|£| Commnn(IWindowL-ﬂ_. Bookmnrksl_—"l Output] ] Immediate W'ln(lowl
Ready 4

Figure 3-2: These property pages let you define project resources, settings, and general configuration.
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Assembly Information

Title: IMy Windows Application
Description: IA sample with assembly information.
Company: IUB Helper
Product: I\*ﬁn(lowsApplicatiom
Copyright: !Copylight © 2005, VB Helper
Trademark: I
Assembly Version: |1 Iﬂ IO |0
File Version: |1 iu o |n
GUID: I5960c33{|-5122-45e0-9ef8-20f(l(le794ff8
Hewutral Language: Iﬂlonel j
[~ Make assembly COM-Visible
0K I Cancel |

Figure 3-3: The Assembly Information dialog lets you
define basic project information such as title, copyright,
and version number.

An assembly is the fundamental unit of deployment and version control in Visual Studio .NET. An
assembly can contain an executable application, a DLL, or control library. Usually a project is contained
in a single assembly.

The Assembly Information dialog lets you define information that should be associated with the assem-
bly, including the assembly’s company name, description, copyright, trademark, name, product name,
title, and version (which includes major, minor, revision, and build values).

The My .Application.AssemblyInfo namespace provides easy access to these values at run time. The
following code shows how a program can display this information in a series of labels when it starts.

Private Sub Forml_Load(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles MyBase.Load

1blCompanyName.Text = My.Application.Info.CompanyName
1blDescription.Text = My.Application.Info.Description
1blCopyright.Text = My.Application.Info.Copyright
1blTrademark.Text = My.Application.Info.Trademark
1blDirectoryPath.Text = My.Application.Info.DirectoryPath
1blProductName.Text = My.Application.Info.ProductName
1blTitle.Text = My.Application.Info.Title

1blVersion.Text = My.Application.Info.Version.ToString

End Sub
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Code File Structure

A form, class, or code module should contain the following sections in this order (if they are present):

a Option statements — Option Explicit, Option Strict, or Option Compare.

Q  Imports statements — These declare namespaces that the module will use.

Q A Mainsubroutine — The routine that starts execution when the program runs.

a Class, Module, and Namespace statements — As needed.
Some of these items may be missing. For example, Option and Imports statements are optional. Note
that an executable Windows program can start from a Main subroutine or it can start by displaying a

form, in which case it doesn’t need a Main subroutine. Classes and code modules don’t need Main
subroutines.

The following code shows a simple code module. It sets Option Explicit On (variables must be declared
before used) and Option Strict On (implicit type conversions cause an error). It imports the System. I0
namespace so the program can easily use classes defined there. It then defines the Employee class.

Option Explicit On
Option Strict On

Imports System.IO

Public Class Employee

End éiéss
Usually, you put each class or module in a separate file, but you can add more Class or Module state-
ments to a file if you like. Figure 3-4 shows a code module that contains two classes and two modules.

Class and Module statements define top-level nodes in the code hierarchy. Click the minus sign to the
left of one of these statements to collapse the code it contains. When the code is collapsed, click the plus
sign to the left of it to expand the code. In Figure 3-4, the BillingTools module and Employee class are
collapsed, hiding whatever code they contain.

The project can freely refer to any public class, or to any public variable or routine in a module. If two
modules contain a variable or routine with the same name, the program can select the version it wants by
prefixing the name with the module’s name. For example, if the AccountingTools and BillingTools
modules both have a subroutine named ConnectToDatabase, the following statement executes the ver-
sion in the Bi11ingTools module:

BillingTools.ConnectToDatabase
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@0 ModulesAndStuff - Microsoft Visual Studio
File Edit Wiew Project Build Debug Data Tools Window Community Help
- -5 e @ % a9 -0 -EL| p Debug - AnyCRU - |

IASbh a|EsE|Z22 0P R &5

B s

[lelonhq uonnjes [?z-.| |s-?r!u9(|o 1d Q

L Accounting Tools.wb' rf:orm1.uh| Forml.vh [Design]| -

|“‘L; Customer ﬂ Igi.i([leclarations]

-] Module LecountingTools

|~End Module

@[Module BillingTools .. .|

42/@[Public Class Employee ...|

F Pukblic Class Customer

|mmn05 emuE—"| |xoq|001x|
[
[ o
N
[P ]ILe]]®

1z0 |~End Clazz

pE= | _>I_I
|_;j Error List| ./ Task List|:| Command W’lndow|JE. Bookmarks | =] Output | =] Immediate Wimlow|
Ready Ln 119 Col 5 Ch5 INS -

Figure 3-4: A single file can contain multiple Class and Module statements.

Code Regions

Class and Module statements define regions of code that you can expand or collapse to make the code
easier to understand. Similarly, you can use the Region statement to organize your code. You can place
subroutines that have a common purpose in a region so you can collapse and expand the code as needed.
The following code shows a simple region:

#Region "Drawing Routines"
#End Region

Note that the IDE’s search-and-replace features normally work only on expanded regions. If you col-
lapse a region and make a global search-and-replace in the current document or the current selection, the
collapsed code remains unchanged. If you make a global replace throughout the whole project, the
replacement occurs within collapsed regions as well.

By itself, the End Region statement does not tell you which region it is ending. You can make your code

easier to understand, particularly if you have many regions in the same module, by adding a comment
after the End Region statement giving the name of the region, as shown in the following code:
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#Region "Drawing Routines"
#End Region ' Drawing Routines

Sometimes it may be easier to move related pieces of code into separate files. The Partial keyword
allows you to place parts of a class in different files. For example, you could move a form’s code for
loading and saving data in a separate file and use the pPartial keyword to indicate that the code was
part of the form. Chapter 15, “Classes and Structures,” describes the Partial keyword in detail.

However, you cannot use the Partial keyword with modules so a module’s code must all go in one
file. In that case, you can use regions to similarly separate a group of related routines and make the code
easier to read.

Conditional Compilation

Conditional compilation statements allow you to include or exclude code from the program’s compila-
tion. The basic conditional compilation statement is similar to a multiline If Then Else statement. The
following code shows a typical statement. If the value conditionl is True, the code in code_block_1
is included in the compiled program. If that value is False but the value condition2 is True, the code
in code_block_2 becomes part of the compiled program. If neither condition is True, the code in
code_block_3 is included in the program.

#If conditionl Then
code_block 1...
#ElseIf condition2 Then
code_block_2. ..

#Else
code_block_3...
#End If

It is important to understand that the code not included by the conditional compilation statements is
completely omitted from the executable program. At compile time, Visual Studio decides whether a
block of code should be included or not. That means any code that is omitted does not take up space in
the executable program. It also means that you cannot set the execution statement to omitted lines in the
debugger because those lines are not present.

In contrast, a normal If Then Else statement includes all the code in every code block in the executable,
and then decides which code to execute at run time.

Because the conditional compilation statement evaluates its conditions at compile time, those conditions
must be expressions that can be evaluated at compile time. For example, they can be expressions con-
taining values that you have defined using compiler directives (described shortly). They cannot include
values generated at run time (such as the value of variables).

In fact, a conditional compilation statement evaluates its conditions at design time, so it can give feed-
back while you are writing the code. For example, if Option Explicit is set to On, then Visual Basic
flags the following a